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Preface

Purpose of the
Manual

Audience

Where is this
Manual Valid?

This manual supports you when converting S5 programsinto S7. With the
information in this manual you can do the following:

e Convert existing S5 programsinto S7 programs and subsequently edit them
manually if necessary.

* Incorporate pre-converted S7 functions (previous S5 standard function
blocks) into your S7 programs.

Thismanual isintended for programmers who wish to use existing S5
programsin S7.

This manual isvalid for release 4.0 of the STEP 7 programming software.

From S5 to S7, Converter Manual
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Preface

Where Does this
Manual Fit in with
the Rest of the S7
Documentation?

There isawide range of user documentation available to support you in
configuring and programming an S7 programmable controller which is
intended to be used selectively. The following explanations should make it
easier for you to use the user documentation.

D

This symbol indicates the order in which you should read the
manuals, particularly if you are a first-time user of S7.

Symbol |

Meaning

L]

[
L

1

Prime S7-300 Programmable Controller
r Quick Start

130/

Program Design

System Software for S7-300/S7-400

This documentation introduces the methodology.
This is a reference manual on a specific topic.
The documentation is supported by online help.

Manuals on
S7-300/S7-400
Hardware

Manual

Standard Software for
User Standard Software for S7 and Converter| From S5 to S7
Manual STEP 7 ’\>Manual
V
1230/
- I | - n [ |
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Ixxx/: Number in the list of references
Figure 1-1 S7 Information Landscape
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Preface

Table 1-1

S7 Documentation Content

Title

Subject

S7-300 Programmable
Controller

Quick Start,

Primer

The Primer offers a basic introduction to the methodology of the structure and
programming of an S7-300/S7-400. It is especially suited to first-time users of an S7
programmable control system.

S7-300 and S7-400
Program Design
Programming Manual

The S7-300/S7-400 Program Design Programming Manual provides basic
information on the structure of the operating system and of a user program of an S7
CPU. The first-time user of an S7-300 or S7-400 should use this manual to acquire an
overview of the programming methodology and to use it to base their user program
design on.

S7-300 and S7-400
System and Standard
Functions

Reference Manual

The S7 CPUs have integrated system functions and organization blocks included with
their operating system, which you can use when programming. The manual provides
you with an overview of the system functions, organization blocks, and loadable
standard functions available in S7, and — in the form of reference information —
detailed interface descriptions for their use in your user program.

STEP 7
User Manual

Converter Manual
From S5to S7

The STEP 7 User Manual explains the main usage and the functions of the STEP 7
automation software. As afirst-time user of STEP 7 and as an experienced user of
STEP5, this manual will provide you with an overview of the procedures used to
configure, program, and start up an S7-300/S7-400.

While you are working with the software you can access a range of online help topics

which offer detailed support on using the software.

You will need the From S5 to S7 Converter Manual if you want to convert existing S5
programs to run them on S7 CPUs. The manual provides an overview of the
procedures and usage of the Converter; you can find a detailed description of the
converter functions in the online help. You will aso find the interface descriptions for
the converted S7 functions available in the online help. Practical information is also
provided on SIMATIC S7 hardware and software.

Statement List, Ladder
L ogic, Function Block
Diagram, SCL1
Manuals

The manuals for the programming language packages Statement List, Ladder Logic,
Function Block Diagram, and SCL (Sequential Control Language) contain both the
user’s guide and the reference description of the programming language or
representation type. You only require one language type for programming an
S7-300/S7-400, but you can mix the languages within a project, if required. If you are
using alanguage for the first time, it is recommended that you use the manual to learn
about the methodology of creating a program in the chosen language first.

While you are working with the software you can access a range of online help topics
which offer detailed support on using the respective editors/compilers.

GRAPH1!  HiGraphl,
CFc?
Manuals

The languages GRAPH, HiGraph, and CFC (Continuous Function Chart) offer
additional methods of programming blocks in the form of sequential controls, state
graphs, or charts. The manuals contain both the user’s guide and the reference
description of the programming language. If you are using alanguage for the first
time, it is recommended that you use the manual to learn about the methodology of
creating a program in the chosen language first.

While you are working with the software you can access a range of online help topics
which offer detailed support on using the respective editors/compilers (with the
exception of HiGraph).

1 Optional package for system software for S7-300/S7-400

From S5 to S7, Converter Manual
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Preface

Structure of the
Manual

Conventions

Additional
Assistance

Notes

\Y

This manual assumes you have knowledge of S7 programs which you can read
about in the Programming Manual /234/. You should also be familiar with
using the Standard software, as described in the User Manual /231/.

The manual is divided according to the following topic areas:

e Part 1 (Chapters 1 to 3) explains how to plan your conversion from S5 to
S7.

e Part 2 (Chapters 4 to 9) explains how to convert programs with the
converter.

¢ Chapter 9 contains application examples.

e TheAppendix is areference section on al STL instructions (international
and German mnemonics) provided for reference purposes.

* The Glossary explainsimportant terms.

e Thelndex will help you to locate text passages on important subjects
quickly and easily.

References to other manuals are shown using the part number of the literature
between dashes/.../. Using these numbers you can find out the exact title of
the manual from the literature list at the end of this manual.

If you have any questions regarding the software described in this manual and
cannot find an answer here or in the online help, please contact the Siemens
representative in your area. You will find alist of addressesin the Appendix of
[70/ or /200/, or in catalogs, and in Compuserve (go aut f or unj . You can
also speak to our Hotline under the following phone or fax number:

Tel. (+49) (911) 895 7000 (Fax 7001)

If you have any questions or comments on this manual, please fill out the
remarks form at the end of the manual and return it to the address shown on the
form. We would be grateful if you could also take the time to answer the five
guestions giving your personal opinion of the manual.

Siemens also offers anumber of training courses to introduce you to the
SIMATIC S7 automation system. Please contact your regional training center
or the central training center in Nuremberg, Germany for details:

D-90327 Nuremberg, Tel. (+49) (911) 895-3154.

This manual replaces the older “ Converting S5 Programs’ User Manual. In
other manuals, this manual may still be referred to under its old name or
simply as the Converter Manual.

From S5 to S7, Converter Manual
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Introduction

1

Until now you were familiar with the name SIMATIC as the synonym for
SIEMENS programmabl e controllers of the S5 family. Now the name
SIMATIC stands for fully integrated automation.

The concept fully integrated automation describes a revolutionary new way
of combining the worlds of manufacturing and process engineering. All
hardware and software components are integrated into one single system:
SIMATIC.

This complete integration is made possible by the universal compatibility
offered by the S7 system in the following three areas:

¢ Database

Data are only entered once and are then available to awhole factory.
Transfer errors and inconsistencies are therefore a thing of the past.

e Configuring and programming

All the components and systems belonging to atask are planned,
configured, programmed, commissioned, debugged, and monitored with
one single fully integrated software package with a modular design - under
one user interface and with the most suitable utility.

¢ Communication

“Who communi cates with whom” is determined simply in a connection
table and can be changed at any time. The various network types can be
configured easily and uniformly.

To be able to meet the wide range of possibilities of SIMATIC as afully
integrated system, brand new concepts have been shaped in SIMATIC S7.
Some functions are therefore achieved in other ways to those you are familiar
with in S5.

The STEP 7 programming software is based on new technology and concepts.
For example, the user interface is designed to meet modern ergonomic
reguirements and runs under Windows 95/NT. In our programming languages,
we have endeavored to adhere to the IEC 1131 standard as closely as possible
without becoming incompatible with STEP 5.

From S5 to S7, Converter Manual

A5E00261402-01



1-2

We are convinced that our new STEP 7 system meets the following demands:
* A software basis for fully integrated automation

¢ Programming which conformsto IEC 1131

e Compatibility with STEP 5

We are also aware that converting from an existing system to a new system
gives rise to anumber of questions and we recognize that it will be necessary
to make certain adaptations, particularly with regard to the software.

Thismanual isintended to provide answers to these questions and, at the same
time, show you simple ways in which you can continue to use your existing
STEP5 programsin SIMATIC S7.

From S5 to S7, Converter Manual
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Hardware 2

This chapter describes the hardware that can be used for S7 and makes
comparisons, when necessary, with the hardware used for S5, in order to
facilitate the transition from S5 to S7.

Converting The Siemens CD-ROM *“ Components for Automation” / catalog CA01 (from
Hardware from S5 4/97) contains an application designed to aid you in choosing hardware when
to S7 using the converting from S5 to S7. To access the catalog of products, select the menu
Siemens Catalog command Auswahlhilfen > Simatic. Here you can enter any S5 system

on CD-ROM desired; the application uses this system data to create arack configuration and

asignal list. You can then convert this S5 configuration to an S7 configuration.

From S5 to S7, Converter Manual
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Hardware

2.1 Programmable Logic Controllers

SIMATIC S7-200

SIMATIC S7-300

SIMATIC S7-400

SIMATIC S7 consists of the following three types of programmable logic
controllers classified according to their performance range:

SIMATIC S7-200 is a compact micro programmable logic controller (PLC)
designed for applications having the lowest performance range. S7-200 is
controlled by its own system-specific software package which is not included
in the following comparison of S5 and S7.

SIMATIC S7-300 is amodular mini controller designed for applications
having alow performance range.

SIMATIC S7-400 is designed for applications providing an intermediate to
high performance range.

For easy reference, S7-300 module names always start with a“3” and S7-400
module nameswith a“4”.

performance range

Intermediate
performance range

S5-115U

High s5-135U [[fi SIMATIC
S7-400
1
1 $5-155U
CPU 944/945
AL
Il SIMATIC

S7-300 [

CPU
941-943 I

S5-95U =
1 i

“I
Lower S5-90U [ S5-100U
performance range 1t
— SIMATIC
S7-200 — ggg

_ FEE‘ } compact

Figure 2-1 SIMATIC Programmable Controllers

2-2
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Hardware

Connecting
Programming
Devices and OPs
to SIMATIC S7

Programming device interface MPI (Multipoint I nterface) for
programming devices and operator panels

The programming device interface AS511 used in SIMATIC S5 has been
replaced by the multipoint interface, MPI (for S7-300 and S7-400). This
multipoint interface provides a direct electrical connection for HMI devices
(HMI: Human Machine Interface, previously known as COROS) and for
programming devices to the programming device interface used by SIMATIC
S7. The interfaces are completely integrated.

The following table provides a direct comparison of these two interface
specifications:

AS511 MPI
25-pin TTY interface (20 mA) 9-pin sub-D interface with RS485
technology
Transmission rate: 9.6 Kbps Transmission rate: 187.5 Kbps
Protocol: 3964R Protocol: S7 functions

Max. length of network: 50 m

(with bus amplifiers or special
cables: up to 1000 m)

All programmable modules within a
configuration can be addressed via
the multipoint interface

One device can be connected . Up to 31 devices can be connected

Businterface for Operator Panels (OP)

Programmable logic controllersin the SIMATIC S5 and SIMATIC S7
automation families can be connected using the PROFIBUS (previously
known as SINEC L2) bus system. As before, these connections are
bus-specific.

From S5 to S7, Converter Manual
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Hardware

2.2 S7 Modules

No Fundamental
Differences from
S5

New Performance
Characteristics

The range of modules used in S7 corresponds to and expands on the known
and proven module concept used in SIMATIC S5.

S7 contains the following types of modules:

Central processing units (CPU)

Power supply modules (PS)

Interface modules (IM)

Communications processors (CP); (such as for connecting to PROFIBUS)

Function modules (FM); (such as for counting, positioning, closed-loop
control)

Digital and analog modules are now called “ signal modules’ (SM)

This chapter describes the similarities and differences in the range of modules
used in SIMATIC S5 and SIMATIC S7.

S7 modules can be distinguished by the following features:

The new modules are not equipped with jJumpers or switches.

The new modules do not require cooling fans. Asin S5, they have the [P 20
protection class.

The new modules can be assigned parameters and have diagnostic
capability.
The S7 dot assignment is more flexible than for S5.

Expansion devices and ET 200 distributed 1/0 devices can trigger
interrupts.

From S5 to S7, Converter Manual
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Hardware

Comparison of

Module Parameter

Assignment in S5
and S7

The following table compares the module parameter assignment in SIMATIC
S5 and SIMATIC S7:

SIMATIC S5

SIMATIC S7

Modules are arranged (hardware
configuration) using the STEP 7
application for configuring hardware

Addresses are set with DIL switches

Addresses are set with the STEP 7
application for configuring hardware
or are slot-oriented

System behavior is set with DIL
switches

Module parameters are assigned
with the STEP 7 application for
configuring hardware

CPU parameters for operational
behavior are assigned via system
dataareasor DB1/ DXO0

From S5 to S7, Converter Manual
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Hardware

2.2.1  Central Processing Units (CPU)

S7-300 CPUs Table 2-1 lists the most important performance specifications for S7-300
CPUs. If you want to replace an S5 CPU, you can use the following table to
compare performance in order to select the most suitable CPU:

Table 2-1 Performance Features of the S7-300 CPUs

Feature CPU 312 IFM CPU 313 CPU 314 CPU 314 1FM CPU 315 CPU
315-2DP
Work memory 6 Kbytes 12 Kbytes | 24 Kbytes 24 Kbytes 48 Kbytes
(integrated)
Load memory
* integrated 20 Kbytes RAM; | 20 Kbytes | 40 Kbytes | 40 Kbytes RAM; | 80 Kbytes RAM
20 Kbytes RAM RAM 40 Kbytes
EEPROM EEPROM
* expandable with - upto512 |upto512 - up to 512 Khytes
memory card Kbytes Kbytes (in CPU programmable
up to 256 Kbytes)
Processimage size, | 32 bytes 128 bytes | 128 bytes | 124 bytes 128 bytes
inputs and outputs | + 4 on-board + 4 on-board
1/0O address area Inputs: 128 128 512 Inputs: 496 1024
. digital + 10 on-board + 20 on-board
inputs/outputs | Outputs: 128 Outputs: 496
+ 6 on-board + 16 on-board
e anaog 32 64 Inputs: 64 128
inputs/outputs + 4 on-board
Outputs: 64
+ 1 on-board
Bit memory 1024 2048
Counters 32 64
Timers 64 128
Max. sum of 72 bytes 4736 bytes 144 bytes 4736 bytes
all retentive data
Local data 512 bytesin 1536 bytesin total;
total; 256 bytes per priority class
256 bytes per
priority class
Blocks:
OBs 3 13 13 13 13 14
FBs 32 128 128 128 128 128
FCs 32 128 128 128 128 128
DBs 63 127 127 127 127 127
SFCs 25 44 48 48 48 53
SFBs 2 7 7 14 7 7

2-6
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Hardware

S7-400 CPUs The CPUs for the S7-400 have different performance features. Table 2-2 shows
a comparison of the performance features of these CPUs.
Table 2-2 Performance Features of the S7-400 CPUs
Feature CPU CPU CPU CPU CPU CPU CPU
412-1 413-1 413-2 DP 414-1 414-2 DP 416-1 416-2 DP
Work memory 128 128/384 512 0.8/1.6
(integrated) 48 Kbytes 72 Kbytes Kbytes Kbytes Kbytes Mbytes
Load memor
_ y 8 Kbytes 8 Kbytes 16 Kbytes
e integrated
* expandable with
memory card up to 15 Mbytes up to 15 Mbytes up to 15 Mbytes
_Pr OCESS IMaYE SIZ€, 128 bytes each 256 bytes each 512 bytes each
inputs and outputs
1/0 address area 2 Kbytes 8 Kbytes 16 Kbytes
* digital inputs/outputs 16384 65536 131072
max.
* analog inputs/outputs 1024 4096 8192
max.
Bit memory 4096 8192 16384
M 0.0to M 511.7 M 0.0 to M 1023.7 M 0.0 to M 2047.7
Counters 256 256 512
C0toC 255 C0toC 255 COtoC511
Timers 256 256 512
TOtoT 255 TOtoT 255 TOtoT511
Local data 4 Kbytesin total 8 Kbytesin total 16 Kbytesin total
Blocks:
OBs 23 31 44
FBs 256 512 2048
FCs 256 1024 2048
DBs 511 1023 4095
SFBs 24 24 24
SDBs 512 512 512
SFCs 55 | 5 | 58 55 | 58 55 | 58

Retentive Features
of S7-400

Retentive Features
of S7-300 without
Backup Battery

Parameter
Assignment for the
Retentive Feature

The CPUs for SIMATIC S7-400 require a backup battery to buffer timers,
counters, and bit memory.

The CPUs for S7-300 do not require a battery to buffer timers, counters, or bit
memory. Similarly, the contents of data blocks can also be retained in the event
of apower failure. The CPUs for SIMATIC S7-300 have a maintenance-free
backup that saves those addresses and data which have parameters specifying
that they be retained in event of a power failure.

The size and quantity of the available retentive areas depend on the respective

CPU.

The size of the data retention areas is set in parameter assignment dialog boxes
during hardware configuration with STEP 7.

From S5 to S7, Converter Manual
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Hardware

2.2.2 Power Supply Modules (PS)

Power Supply

Modules for S7-300

Power Supply

Modules for S7-400

A selection of power supply modulesis available for each programmable logic
controller (PLC).

Any 24-volt power source (industrial) can be used to supply to the CPU in
S7-300.

The range of modulesin S7 contains the following power supplies specifically
designed for S7-300:

Module Name Output Output Input
Current Voltage Voltage
PS 307 2A 24VDC 120/ 230 VAC
PS 307 5A 24VDC 120/ 230 VAC
PS 307 10A 24VDC 120/ 230 VAC
Module Name Output Output Input
Current Voltage Voltage
PS 407 4A 4A 5VvDC 120/ 230 VAC
05A 24\VDC
PS 407 10A 10A 5VvDC 120/ 230 VAC
1A 24VDC
PS 407 20A 20A 5VvDC 120/ 230 VAC
1A 24VDC
PS 405 4A 4A 5VDC 24VDC
05A 24VDC
PS 405 10A 10A 5VvDC 24VDC
1A 24VDC
PS 405 20A 20A 5VvDC 24VDC
1A 24VDC

For further information, see the Reference Manuals/71/ and /101/.
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2.2.3 Interface Modules (IM)

Comparison of IM
Modules

Some interface modules in S5 have been replaced in S7. This change primarily
affectslocal area connections. In S7, it is recommended that PROFIBUS be

used to transmit signals for remote area connections.

Connectable S5
Expansion Racks

S5 Module S7-300 Module S7-400 M odule Description
IM 305 IM 365 IM 460-0/IM 461-0 Central configuration
IM 306 IM 360/ 1M 361 IM 460-1/ 1M 461-1
IM 300/ IM 312
- - IM 460-3/IM 461-3 Remote area (up to
100 m)
IM 301/IM 310 Connection via Connection via Connection of 110
PROFIBUS PROFIBUS modules and signal
preprocessing modules
(up to 200 m)
IM 304/1IM 314 Connection via Connection via Use of distributed I/O in
PROFIBUS PROFIBUS remote areas (up to
600 m)

IM 463-2 Distributed connection
of S5 expansion devices
in remote areas (up to
600 m)

IM 307 /1M 317 Connection via Connection via Connection via
PROFIBUS PROFIBUS fiber-optic cable (up to
1500 m)
IM 308/IM 318 Connection via Connection via Distances up to 3000 m
PROFIBUS PROFIBUS

In S7, the interface module IM 467 can be used in place of IM 308C.

You can use the interface module IM 463-2 to connect S5 digital and analog
modules to the S7 mounting rack with IM 314 viaan S5 expansion rack.

The following S5 expansion racks can be connected:
EG 183 expansion unit

e EG 185 expansion unit

* ER701-2
e ER701-3
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2.2.4  Communications Processors (CP)

The following section lists the S5 and S7 communi cations processors that can
be used in various subnets. In addition, the services supported by these
processors are also indicated.

Subnets in In order to meet the varying requirements of different automation levels (such
SIMATIC as on the processing, cell, field, and actuator-sensor levels), SIMATIC provides

the following subnets:

2-10

ASInterface

The actuator-sensor interface (AS-i) is a connection system for the lowest
processing level in automation systems. It is primarily used for networking
binary sensors and actuators. Its data quantity is limited to a maximum of
4 bits per dave.

MPI

The multipoint interface (MPI) subnet isintended for short-range field and
cell levels. The MPI isamultipoint interface used in SIMATIC S7/M7 and
C7. It isdesigned as a programming device interface and is intended for
networking a small number of CPUs and for exchanging small quantities
(up to 70 bytes) of data.

PROFIBUS

PROFIBUS is the network used for the cell and field areasin open,
manufacturer-independent, SIMATIC communication systems. PROFIBUS
is suitable for quick transmission of moderate quantities of data (approx.
200 bytes).

Industrial Ethernet

Industrial Ethernet isthe network used for the processing and cell levelsin
open, manufacturer-independent, SIMATIC communication systems.
Industrial Ethernet is suitable for quick transmission of large quantities of
data.

Point-To-Point Connection

A point-to-point connection is not a subnet in the traditional sense. This
connection is established in SIMATIC by using point-to-point
communications processors (CP) to connect two communication partners
(such as PLCs, scanners, PCs) with each other.
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AS Interface The following table provides an overview of the modules available for
(SINEC S1) communicating via the actuator-sensor (AS) interface.

S5 Module S7-300 Module S7-400 Module

CP 2433 (AS-i functions) CP 342-2 (AS-i functions) -
CP 2430 (AS-i functions)

MPI (SINEC L1) Communication viaSINEC L1 in S5 has been converted to global data
communication using MPI in S7.

All CPUs in S7-300 and S7-400 as well as the programming devices and
operator panels have an MPI interface.

PROFIBUS The following table provides an overview of the modules available for
(SINEC L2) communicating with PROFIBUS and which services are supported by these
modules.
S5 Module S7-300 Module S7-400 Module
CP 5431 (FMS, FDL, DP) CP 342-5 CP 443-5 Ext.
CPU 95U (FDL, DP*)) (S7 functions, FDL, DP) (S7 functions, FDL, DP)
CP 343-5 CP 443-5Basic
(S7 functions, FDL, FMS) (S7 functions, FDL, FMS)
IM 308-B/C (DP) CPU 315-2 DP (DP) CPU 413-2 DP (DP)
CPU 414-2 DP (DP)
CPU 416-2 DP (DP)
IM 467 (DP)

*) depends on the specific equipment ordered

Industrial Ethernet The following table provides an overview of the modules available for

(SINEC H1) communicating with Industrial Ethernet and indicates which services are
supported by these modules.
S5 Module S7-300 Module S7-400 Module
CP 1430 TF (1SO transport) CP343-1 CP443-1
(S7 functions, 1SO transport) (S7 functions, 1SO transport)
CP 1430 TCP (ISO on TCP) CP343-1TCP CP443-1TCP
(S7 functions, 1SO on TCP) (S7 functions, 1SO on TCP)
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Point-To-Point

The following table provides an overview of the modules available for

Connection point-to-point connection and which services are supported by these modules.
S5 Module S7-300 Module S7-400 Module
CP 521 (3964(R), ASCII) CP 340-RS 232C (3964(R), CP 441-1 (3964(R), RK512,
CP 523 (3964(R), ASCII) ASCII) ASCII)
CP 340-20 mA (3964(R),
ASCII)

CP 340-RS 422/485 (3964(R),
ASCII)

CP 544 (3964(R), RK 512,
ASCII)

CP 524/525 (3964(R), RK 512,
ASCII, additional special drivers
which can be loaded

CP 544 B (3964(R), RK 512,
ASCII, additional special drivers
which can be loaded

2-12

CP 441-2 (3964(R), RK512,
ASCII, additional special drivers
which can be loaded
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2.2.5  Function Modules (FM)
Some |P and WF modulesin SIMATIC S5 can be used in S7-400 with the help
of aspecial adapter casing. In other cases, there are new function modules
available in S7 to help you obtain the functionality desired.
The following table provides an overview and comparison of the signal
preprocessing modules available in S5 and S7.
Table 2-3 Comparison of Signal-Preprocessing Modulesin S5 and S7
S5 Module Adapter S7Module Description
Casing
IP 240 yes FM 451 Counter, position detection, and positioning modules
(limited)
1P 241 no FM 451/ Digital position detection module
FM 452
(limited)
IP 242A no no Counter module
1P 242B yes no Counter module
1P 244 yes FM 455 Controller module
IP 2461/A yes FM 354/ Positioning module for variable speed drives
FM 357/
FM 453
1P 247 yes FM 353/ Positioning module for stepper motors
FM 357/
FM 453
IP 252 no FM 455 Closed-1oop control module
(limited)
IP 260 no FM 355 Closed-loop control module
(limited)
IP 261 no no Proportioning module
1P 281 no FM 350-1/ Counter module
FM 450-1
IP 288 no FM 451/ Positioning module for regulating rapid/creep feed
FM 452 and cam control
WF 705 yes FM 451 Position detection module
(limited)
WF 706 no FM 451 Positioning and counter module
(limited)
WEF 707 no FM 452 Cam control
(limited)
WF 721 yes FM 354 Positioning module
(limited
because of
assembly
technology)
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Table 2-3 Comparison of Signal-Preprocessing Modulesin S5 and S7, continued
S5 Module Adapter S7 Module Description
Casing
WF 723A yes FM 453 Positioning module
WF 723 B yes FM 357 Positioning module
(limited
because of
assembly
technology)
WF723C yes no Positioning module
- - FM 456-4 Application module (M7-FM)
- - SINUMERIK | Numeric control
FM-NC
- - FM Stepper motor control
STEPDRIVE
- - SIMOSTEP Stepper motor

2-14
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2.2.6

Signal Modules
which can be
Assigned
Parameters

Signal Modules
with Diagnostic

Signal Modules (SM)

The signal modulesin SIMATIC S7 are comparable in function to the
input/output modules in S5. However, in addition to simple signal modules, S7
a so provides modules that can be assigned parameters and which have
diagnostic capability.

Digital input modulesin S7 that can be assigned parameters allow you to
specify (with the STEP 7 application for configuring hardware) which
channels are to trigger a hardware interrupt on edge change.

The input ranges of analog input modules can be easily assigned parameters
with STEP 7.

Modules with diagnostic capability can detect both external errors such aswire
breaks or external short circuits and internal ones such as RAM errors or short

Capability circuits within modules.
A diagnostic event is processed by the controller in the following two ways:
* By triggering adiagnostic interrupt. This notifies the appropriate
organization block (OB) in the user program, which then interrupts the
cyclic program.
* By making an entry in the diagnostic buffer of the CPU, which can then be
read with a programming device or operator interface device.
The following tables list the signal modules available in S7:
Table 2-4 Signal Modulesin SIMATIC S7-300
DI DO Al AO
(SM 321) (SM 322) (SM 331) (SM 332)
32x24VDC 32x24VDC/05A 8 x 12 bit 2 x 12 hit
16 x 24 VDC 16 x 24 VDC/05 A 2x 12 bit
16 x 24 VDC with 8 x 24 VDC/0.5 A with Ex: 4 x 15 bit Ex: 4 x 15 bit
hardware and diagnostic | diagnostic interrupt
interrupt
16 x24VDC 8x24VDCI2 A Ex: 12 x 15 bit
M-reading
8x 120/230 VAC 8 x 120/230VAC/ Al 4/AO 2 X 8/8 bit (SM 334)
2A
Ex: 4x24VDC Ex: 4x 15 VDC/
20mA
Ex: 4x 24 VVDC/
20mA

From S5 to S7, Converter Manual

A5E00261402-01

2-15




Hardware

Table 2-5 Signa Modulesin SIMATIC S7-400
DI DO Al AO
(SM 421) (SM 422) (SM 431) (SM 432)
32xDC24V 32x24VDC/0.5A | 8x 13 hit 8 x 13 bit
16 x 24/60 VUC 16x24VDC/2 A 8 x 14 bit
with hardware and (for temperature
diagnostic interrupt measurement)
16 x 120/230 VUC | 16 x 120/230 VAC | 8x 14 bit
/5A
32x120VvUC 16 x 120/230 VAC | 16 x 16 hit
2A
16 x 30/230 VUC/
Rel.5A
2.2.7  Simulation Modules (S7-300)

2-16

S7-300 provides a simulation module, SM 374, for testing your program.

This simulation module has the following capabilities:

¢ |t can simulate

— 16inputs,

— 16 outputs, or

— 8inputs and 8 outputs (each having the same initial address)

¢ [tsfunctions can be set with a screwdriver

¢ It can provide status displays for simulating inputs or outputs
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2.3 Distributed I/O Devices

The modules for distributed I/O devicesin the ET 200 system which already
existed in SIMATIC S5 can continue to be used in SIMATIC S7.

In addition, there are new ET 200 modules to extend the range.

DP Masters The following modules can be a DP master in the distributed 1/0 system:
e S7-300 with CPU 315-2 DP or CP 342-5 as DP master

e S7-400 with CPU 413-2 DP/ 414-2 DP/ 416-2DP or CP 443-5, extended
as DP master

DP Slaves The following are examples of devices which can be DP slavesin the
distributed 1/O system:

» Distributed I/O devices such as ET 200B, ET 200C, ET 200M, ET 200X
(up to 12 Mbps) and ET 200U, ET 200L (up to 1.5 Mbps)

* Programmable logic controllers such as
— S5-115U, S5-135U, or S5-155U with IM 308-C as DP dave
— S5-95U with DP dave interface (up to 1.5 Mbps)
— S7-300 with CPU 315-2 DP or CP 342-5 as DP dave
— S7-400 with CP 443-5 as DP dave
* Interface to actuator-sensor interface with the DP/AS-i link

* Text displays and operator panels for machine-like operator control and
monitoring

* MOBY identification systems
* Low-voltage switching devices

* Field devices (such as drives, valve idands, etc.) from Siemens or other
manufacturers.

FMS Masters Thefollowing can serve asan FM S master:
* S7-300 with CP 343-5 as FM S master
*  S7-400 with CP 443-5 Basic as FMS master

FMS Slaves Examples of devices that can serve as an FM S slave are the ET 200U or the
SIMOCODE motor protection and control device.

For further information, refer to the appropriate manuals or the Siemens
catalog CAOL.
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2.4 Communication

Services and
Subnets

S7 Functions

ISO Transport

ISO on TCP

FDL (SDA)

2-18

Communication within SIMATIC S7 is based on different subnets which
provide various services.

Services S7 Communication Functions
(S7 Functions)
1SO transport FDL (SDA) GD
1SO-on-TCP FMS
DP
Subnets Industrial PROFIBUS MPI
Ethernet

The following is a summary of the communication services used in SIMATIC:

The S7 functions provide services for communicating between S7/M7 CPUS,
S7 OP/OSs and PCs. These S7 functions are already integrated in each
SIMATIC S7/M7 device. Since these S7 functions correspond to a servicein
the 1SO application layer, they are independent of any one subnet and can thus
be used on al subnets (MPI, PROFIBUS, Industrial Ethernet).

These functions are used for secure data transfer from SIMATIC S7 to
SIMATIC Sb5.

They are used to transfer moderate amounts of data (up to 240 bytes) via open
communication at | SO transport layer 4 based on the | SO reference model for
Industrial Ethernet.

These functions are used for secure data transfer from SIMATIC S7 to
SIMATIC Sb5.

They are used to transfer moderate amounts of data (up to 240 bytes) via open
communication according to the TCP/IP protocol at SO transport layer 4
based on the I SO reference model for Industrial Ethernet.

The ISO-on-TCP service requires the extended RFC1006 standard.

These functions are used for secure data transfer from SIMATIC S7 to
SIMATIC S5.

They are used to transfer moderate amounts of data (up to 240 bytes) via open
communication at Fieldbus Data Link (FDL) layer 2 based on the SO
reference model for Industrial Ethernet.
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FMS

DP

GD

PROFIBUS FM S (Fieldbus Message Specification) provides services for
transferring structured data (FM S variables) over static FM S connections.

The FMS service can be classified at layer 7 of the ISO reference model. It
corresponds to the European standard EN 50170 Vol. 2 PROFIBUS and
provides services for transferring structured data (variables).

PROFIBUS DP services allow transparent communication with distributed 1/0
devices. These distributed 1/O devices are addressed by the control programin
exactly the same manner as centralized 1/0 devices.

Global Data Communication is a simple communication option integrated in
the operating system of S7-300/400 CPUs.

GD communication permits cyclic exchange of data between CPUs viathe
multipoint interface; for S7-400, it also allows event-driven data exchange.
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24.1 Interface to User Programs

The communication interface to a user program consists of the following
blocks:

* SFCs(without connection configuration)
* SFBs (with connection configuration) (only S7-400)
* Loadable FCs/ FBs

These blocks replace the S5 handling blocks. The functionality here is similar,
but it is now accomplished using STEP 7 languages. To establish
communication, you will have to adapt an appropriate S5 program with
handling functions to the new blocks.

Networ k Service Interfacein S5 User Interfacein S7 User
Program Program
Point-to-point - Handling blocks * S7-300: loadable FBs
connection S7-400: loadable SFBs
PROFIBUS FDL Handling blocks * Loadable FCs
(PLC-PLC) Handling blocks * -
FreeLayer2 | Handling blocks * Loadable FBs
FMS
Industrial Ethernet ISO4 Handling blocks * Loadable FCs
ISO4+AP Handling blocks * —
STF Handling blocks* + loadable | —
MAP FBs
Handling blocks * + loadable | Loadable FBs
FBs

* |ntegrated or |oadable, depending on CPU

From S5 to S7, Converter Manual
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2.5 Operator Control and Monitoring

Introduction

Operator Panels

STEP 5

STEP 7

The following section provides an overview of the extent to which SIMATIC
HMI (HMI: Human Machine Interface, previously COROS) operator panels
can beused in SIMATIC S7.

The SIMATIC HMI operator panel provides operator control and monitoring
functions for SIMATIC S5, SIMATIC S7, and SIMATIC Tl, aswell asfor
other controllers.

In general, astandard function block, which is called depending on the
operator panel connected, is required in the programmable controller for
connecting SIMATIC OP to SIMATIC S5.

The following operator panels (OP) can be used with S5:

— TD17, OP5/A1, OP7/PP, OP7/DP-12, OP15/x1, OP17/PR,
OP17/DP-12

— OP25, OP35, OP37, TP37

When connecting SIMATIC OP to SIMATIC S7/M7, adistinction must be
made between PP, MPI, and PROFIBUS as MPI nodes.

PPI or MPI connections run via the programming device interface in the CPU.
In doing so, SIMATIC OP uses the communication services of SIMATIC
S7/IM7 (S7 functions); this means that a standard function block is not
required.

The PROFIBUS connection from SIMATIC OP to SIMATIC S7/M7 aso
involves communication accomplished using S7 functions. Again, this means
that a standard function block is not required. (SIMATIC OPs are “active
nodes’ and not PROFIBUS-DP daves as is the case for the PROFIBUS
connection to SIMATIC S5.) The same number of nodes that appliesto an MP
connection also applies here.

The following operator panels (OP) can be used with S7:

— TD17, OP3, OP5/A2, OP7/DP, OP7/DP-12, OP15/x2, OP17/DP,
OP17/DP-12

— OP25, OP35, OP37, TP37
The following restrictions apply to SIMATIC OPs:
— OP3: up to 2 connections
— OP5/15/25: up to 4 connections
— TD17, OP7/17: up to 4 connections
— OP35: up to 6 connections
— OP37, TP37: up to 8 connections
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Configuration

Integration in
SIMATIC STEP 7

SIMATIC ProTool and SIMATIC ProTool/Lite are modern tools for
configuring operator panels. SIMATIC ProTool can be used to configure all
devices, while SIMATIC ProTool/Lite can only be used to configure
line-oriented operator panels. Functionally, ProTool/Lite is a subset of ProTool.

ProTool can be integrated in the SIMATIC STEP 7 configuration software; this
enables direct access to configuration data such as symbol tables and
communication parameters used for control configuration. This feature not
only saves time and money; it also prevents errors resulting from redundant
dataentry.

Table 2-6 Configuration Tools for Operator Interface Devices

Device

Configuration Tool

OP17)

Line-oriented OP (TD17, OP3, OP5, OP7, OP15, | ProTool/Lite or ProTool

Graphic-oriented OP (OP25, OP35, OP37, TP37) | ProTool

WinCC

2-22

WinCC can be used for asingle or multi-terminal (client-server arrangement)
system.

WinCC isasystem for creating solutions to visualization and process control
tasks used in production and process automation; it is compatible with all
business sectors and technologies. It provides function modules suitable for
displaying graphics and messages, archiving information, and record-keeping
inindustrial applications. Its powerful and efficient hardware connection,
quick display updating, and secure data archiving provide users with high
flexibility and availability.

In addition to these system functions, WinCC also provides open interfaces for
creating user-specific solutions. These allow WinCC to be integrated in
complex, company-wide automation solutions. Integrated features allowing
access to data archives via standard interfaces such as ODBC and SQL and
integration of objects and documents via OLE2.0 and OL E Custom Controls
(OCX) are dso included. These mechanisms make WinCC an effective
communication partner for Windows applications.

WinCC is based on the 32-bit operating systems M S Windows 95 or MS
Windows NT. Both feature preemptive multitasking, which ensures quick
reaction to process events and provides a high level of security against data
loss. Windows NT provides additional security functions and can also serve as
the basis for server operation in a WinCC multi-terminal system. The WinCC
softwareisitself a 32-bit application which was devel oped using the most
modern object-oriented software technology.
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3.1 General Operating Principles

Overview The software for configuring and programming SIMATIC S7/M7/C7 is
designed according to modern ergonomic concepts and is thus largely
self-explanatory.

3.1.1 Installation Requirements

Operating System Microsoft Windows 95.

Standard Hardware  Programming device or PC with the following specifications and equipment:
e A 80486 processor (or higher)
* A minimum 16 Mbytes RAM (32 Mbytes recommended)
* A VGA monitor or other type of monitor supported by Windows 95

* A keyboard, and optional but recommended, a mouse supported by
Microsoft Windows 95

Storage Capacity The following storage space is required on the hard disk:

* The Standard package with one language installed occupies 105 Mbytes on
the hard disk. The exact amount of space required depends on the amount
of standard software installed.

e STEP 7 should also have about 64 Mbytes of total memory available for
storing swap files. For example, if you have 32 Mbytes of RAM, you will
need an additional 32 Mbytes of virtual memory.

e Approx. 50 Mbytes should be available for user data.

* A minimum of 1 Mbyte free memory should be available on the hard disk
for setup. (The setup files are deleted once the installation is compl ete.)
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3.1.2 Installing the STEP 7 Software

Overview

Authorization

STEP 7 contains a setup program that carries out the installation automatically.
User prompts appearing on the screen guide you step-by-step through the
entire installation procedure.

A product-specific user authorization is required to use the STEP 7
programming software. Software protected in this manner can only be used if
the required authorization for the program or software package is located on
the hard disk of the respective programming device or PC.

To obtain this authorization, you need the copy-protected authorization diskette
included in the consignment. This diskette also contains the program
AUTHORS, which isrequired to display, install, and uninstall STEP 7.

The procedure for transferring and removing this authorization is described in
the User Manual /231/.

Note

Siemens programming devices (such as the PG 740) are supplied with
installable STEP 7 software aready on the hard disk.

For further information on installing STEP 7, see the User Manual /231/.
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3.1.3  Starting the STEP 7 Software

Starting After starting Windows 95/NT you will find theicon for the SIMATIC
Manager on the Windows user interface. Thisisthe access point to the STEP 7
software.

Double-clicking the “SIMATIC Manager” icon is the fastest way to start

STEP 7. Thisicon opens the window for the SIMATIC Manager. From here,
you can access the standard system, all optional software, and al functions that
you have installed.

Alternatively, you can also start the SIMATIC Manager by clicking the “ Start”
button in the Windows 95/NT taskbar. The menu title for thisis found under
“Simatic/STEP 7.”

SIMATIC Manager The SIMATIC Manager istheinitial window used for configuring and
programming. Here you can do the following:

e Set up projects

e Configure and assign parametersto hardware

e Configure communication connections

* Create programs

e Test programs and start them running

Access to functions is object-oriented, intuitive, and easy to learn.
You can work with the SIMATIC Manager in the following ways:
» Offline (not connected to a controller), or

* Online (connected to a controller)

(When doing this, be sure to observe the appropriate safety guidelines.)

Edl SIMATIC Manager - zebra H=
File Edit Insert PLC View Options Window Help

DIlgfle|  s[o(e] ] E el @] |

zebra - <Standard Hierarchy, Offline> (Project) — C:\SIEMENS\STEP7\S7pr0j\zeI!E

BR=N zebra | fll SIMATIC 400 Station (1)
il SIMATIC 400 Station | 2.3 ppy (1)

Press F1 for help. [ [ Yy

Figure 3-1 SIMATIC Manager with an Open Project
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3.2 Structure of an S7 Project

Definition

Projects in STEP 5

Projects in STEP 7

Note

3-4

Projects contain all the data and programs for an automation solution. Their
purpose isto provide organized storage of data and programs created for such
an application.

You will aready be familiar with the term “project” from working with
STEPS. In STEP5, aproject contains all STEP 5 files created for one user
program in a project file.

This project file contains information necessary for convenient editing and
maintenance of a user program, such as parameter settings, as well as catalog
and file names.

In STEP 7, aproject contains al the programs and data necessary for an
automation solution, regardless of the number of CPUs involved and how they
are networked. Thus, a project isnot just limited to a user program used for a
particular programmable module; instead, it contains several user programs
used for many programmable modules, which are all stored together under a
Ccommon project name.

Asin STEPS5, itisalso possiblein STEP 7 to create asimple user program
intended for only one CPU. In this case, a project islimited to one CPU.

The following section discusses the directory structure that STEP 7 provides
for the user programs and data that you create.
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Components of a
Project

A project in STEP 7 essentially consists of the objects depicted in Figure 3-2.
These objects are listed and explained below.

isf Project
~7
. - O O O O O O O O oo _.._.
T T T
(11! (11! 1] i
NIl NI N Station ? Network
- @ ...
T T
' I 1. I Programmable /§,®// Connection
module table
m Container for all the
S7 data for a program
[
T T 1
‘ T ‘ @ Symbol table
Program in

source file form

@ @ Blocks

Figure 3-2 Basic Objectsin a STEP 7 Project with their Hierarchical Structure

Network

Station

Hardware

The “Network” object contains the definitive properties for a subnet such as
MPI or PROFIBUS. Assigning a station or a communication module within a
station to a network enables STEP 7 to check communication parameters for
consistency.

A station represents the structure of a programmable controller along with all
the racks belonging to it. If amodule with a DP interface is part of a station,
then the entire master system (that is, the DP slaves belonging to it) is aso part
of this station.

A station consists of one or more programmable modules, such asa CPU.

Hardware is an object containing the configuration data and parameters for a
station. The configuration data and parameters for a station are stored in
system data blocks (SDBs).
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Programmable
Modules

Connection Table

Source Files

Blocks

Symbol Table

3-6

In contrast to other modules, programmable modules contain user programs. In
the folders (known as “containers’ in STEP 7) found in the programmable
modules you will find all the data belonging to the program for the module.
Examples of such programs are the following:

e Programsin source file form (created with atext editor)

When the source program is compiled, executable blocks are created in the
“Blocks’ container.

¢ Blockswhich are loaded into the programmable module
e Symbol tables

The connection table depicts al connections for a programmable module, such
asaCPU, in astation. A connection defines the communication properties
between two nodes and isidentified by a connection ID. This connection ID is
all that you need to program event-controlled communication using
standardized communication blocks, which are similar to the handling blocks
found in STEP 5.

In S7 programming, source files are the basis for creating blocks. Source files
cannot be downloaded to an S7 CPU.

Blocks are distinct parts of a user program and are distinguished by their
function, structure, and use within it. Blocks can be downloaded to S7 CPUs.

In addition to the executable blocks, the “Blocks’ container also contains the
variable tables.

The symbol table shows the assignment of symbolic names, for example, for
inputs, outputs, bit memory, and blocks.
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3.3 Editing Projects with the SIMATIC Manager
3.3.1 Creating Projects

New Project To create a project, follow the steps outlined below:

1. Select the menu command File» New in the SIMATIC Manager.

2. Select the option “New Project” in the “New” dialog box.

3. Enter aname for the project and confirm your entry with “OK.”
Alternative When editing a project, you are flexible as to the order in which you perform

Procedures most of the tasks. Once you have created a project, you can choose one of the
following methods:

* First configure the hardware and then create the software for it, or

e Start by creating the software independent of any configured hardware. The
hardware configuration of a station does not need to be established before
entering a program.

Table 3-1 Alternative Procedures

Alternative 1 Alternative 2
Configurethe hardwarefirst Create the softwarefir st
(see also Section 3.4)
Configure your hardware
(see Section 3.4).
Once the configuration is complete, the“ S7 Insert the required software containers (S7

Program” containers required for creating software | Programs) in your project
are dready inserted and available.

(see Section 3.6).
Then create the software for the programmable Then create the software for the programmable
modules modules
(see Section 3.6). (see Section 3.6).

Configure your hardware

(see Section 3.4).

Link the S7 program to a CPU once you have
configured the hardware.

The procedure for downloading and testing your program without a hardware
configuration is described in the User Manual [231/.
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3.3.2

Overview

Save As...

Archiving

Storing Projects

To back up a project, you can save a copy of the project under another name or
archiveit.

To save the project under another name, proceed as follows:
1. Openthe project.

2. Select the menu command File» Save As. The“Save As’ dialog box is
displayed.

3. Select either save with or without a consistency check and close the dialog
box with “OK.” The “Save As’ dialog box is displayed.

4. Under “SaveIn,” select the directory in which the project isto be saved.

5. Inthe“File Name’ field, enter afile name in place of the asterisk (*). Do
not change the file extension.

6. Close the dialog box with “OK.”

Make sure that there is enough memory available on the drive selected. For
example, it is not advisable to select a disk drive to back up a project because a
project is generally too largeto fit on a diskette. You must archive projects
before saving them on diskettes. Archives can then be split up over several
diskettes.

You can store individual projects or libraries in compressed form in an archive
file located on a hard disk or atransportable data medium (diskette).

In order to be able to access components of an archived project or library, the
project must first be extracted from the archive. Archiving is discussed in
detail in the User Manual [231/.
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3.4 Configuring Hardware with STEP 7

Prerequisite

Inserting a Station

SIMATIC S5 did not provide an option for configuring hardware using the
software. In S7, addressing and assigning parameters to modules and
configuring communicationsis carried out by means of a STEP 7 application.
The advantage of this method is that the user no longer has to make any
settings on the modules, since the configuring and assigning of parameters can
now be done centrally from the programming device.

To configure hardware, a project must already have been created.

To create a new station in a project, open the project to display the project
window (if this has not already been done).

1. Select the project.

2. Create the object for the required hardware by selecting the menu
command Insert » Station.

In the submenu you can select one of the following options:

* SIMATIC 300 station

e SIMATIC 400 station

e PC/programming device

* SIMATIC S5

e Other stations, meaning non-SIMATIC S7/M7 and SIMATIC S5

The stations PC/programming device, SIMATIC S5, and other stations are only
listed for configuring communication links. Configuration and programming of
S5 stationsis not possible.

Click onthe“+" sign in front of the project icon in the project window if the
station is not displayed below it.
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Configuring the
Hardware

Result of
Configuration

3-10

To configure the hardware, proceed as follows:
1. Click the new station you have inserted; it contains the “Hardware” object.
2. Openthe “Hardware” object. The “HWConfig” window is displayed.

3. Inthe“Hardware Configuration” window, plan the structure of the station.
A catalog of modulesis available to help you do this. If thisis not already
displayed, select the menu command View » Catalog to view it.

4. Insert arack from the module catalog in the empty window. Then select the
modules and place them in the rack dots. At least one CPU must be
configured for each station. During this procedure, HWConfig
automatically checks all entries you make.

For further information on configuring hardware, see the User Manual [231].

For each CPU you create in your configuration, an S7 program and a
connection table (“Connections” object) are created automatically once you
have saved and exited the hardware configuration. The S7 program contains
the “Source Files’” and “Blocks’ objects as software containers as well asthe
symbol table.

The“Blocks’ container contains the object for OB1 and the “ System Data’
object with the compiled configuration data.
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3.5 Configuring Connections in the Connection Table

Overview

Special Feature

Loading
Configuration Data

In S5, connections are configured with COM NCM. Thereisa COM package
for each communications processor (CP). In S7, al connections are configured
in the connection table.

Configuring connectionsis a prerequisite for using SFB communication
functionsin auser program.

A connection determines the following:
e The communication partnersinvolved in the S7 project,

* Thetype of connection established (such as an S7 connection or FDL
connection),

* Specia properties such as the active or passive establishment of a
connection or whether operating mode messages are to be sent.

When you configure connections, a unique local identifier (known as the local
ID) isissued for each connection. Thislocal ID isall you require when
assigning communication parameters.

Each CPU that can serve as the end point of a connection has its own
connection table.

If both communication partners are S7-400 stations, alocal 1D is automatically
issued for both end points of the connection. Only one local ID is generated on
the S7-400 station for connections to an S7-300 station.

Thelocal configuration datafor connection end points on an S7 station must
be separately downloaded into each target station.

An (empty) connection table (“Connections’ object) is automatically created
for each CPU. This connection table is used to define communication links
between CPUs in anetwork. After thisis opened, awindow is displayed
containing atable for defining connections between programmable modules
(For more information about defining connections, see the User Manual [231).
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Example: This example shows you how to configure a connection to a SIMATIC S5
Connection to an station. It assumes that you have already inserted a SIMATIC 400 station in
S5 Device your project.

* Insert aSIMATIC S5 station in your project and then set the properties of
the station.

¢ Open the connection table for the S7 station and select the menu command
Insert » Connectionsto insert a connection. A dialog box is displayed in
which you can enter the communication partner (the SIMATIC S5 station)
and the type of connection.

* Onceyou have entered this information, the connection appearsin the
connection table. The properties for the connection must be entered in the
corresponding COM NCM for the S5 station.

Edl Verbpro - zebra\SIMATIC 400-Station(1)\CPU413-1(1) - Configuring Connections
Connection Table  Edit Insert PLC View Help

w8l ] | o v

Station: Module:

[ SIMATIC 400-Station (1) v]  |CPU413-1 (1) ~]

Local ID Partner ID Active Send Operating Mode a
hex. hex. PR Type Connection Setup Messages _I
1000 SIMATIC S5 (1) S7 PtP Connection

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Ready Row 1 - Loc. ID: ISel. 00f0:  #

Figure 3-3 Connection Table
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3.6 Inserting and Editing a Program

The procedure described in this section applies to creating a new program.

3.6.1 Basic Procedure for Creating Software

Overview The software for CPUs is stored in program containers. In SIMATIC S7

modules, such an object is called an “S7 Program.”

The figure below shows an S7 program in the CPU of a SIMATIC 300 station.

H SIMATIC Manager - zebra !E
File Edit Inset PLC View Options Window Help

Dlferm| Lole] w EE s 8kl

zebra - <Standard Hierarchy, Offline> (Project) — C\SIEMENS\STEP7\S7p... M=l

- zebra (O] source Files
Wl SIMATIC 400 Station &| symbols
=] @ SIMATIC 400 Station {3 Blocks

" =-[J cPu314()
ANSEEN] S' Program (2) |
[} {O] Source Files
! {H Blocks
S7 Program (1)

Press F1 for help. [ [ A
Figure 3-4 Open S7 Program in the SIMATIC Manager
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Procedure To create the software for your project, proceed as follows:
1. Open the S7 program.

2. Openthe“Symbols’ object in the S7 program and define the symbols.
(This step can also be done later.) You will find more information on
defining symbolsin Section 3.13.2.

3. Openthe“Blocks’ container if you want to create blocks, or open the
“Source Files” container if you want to create a source file.

4. Insert ablock or asourcefile, as appropriate. (For detailed information, see
Section 3.6.2). The following menu commands are used for this:

— Insert » S7 Software» Block, or
— Insert» S7 Software®» Source File

5. Open the block or source file and enter a program. You will find more
information on programs in the Programming Manual s /232/-/236/.

Depending on your task, you may not need to perform all these steps.

e ‘ S7 Program

Container for all data in
a program

Container for source ' 1 ‘ Container for blocks
files

. Compile ‘
Program in

= - Blocks
source file form @

Generate source file

Figure 3-5 Basic Objectsin a STEP 7 Project and Their Hierarchical Structure
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3.6.2 Inserting Components for Creating Software in S7 and M7

Programs

Existing
Components

Creating S7 Blocks

Using Blocks from
Standard Libraries

Creating Source
Files

Creating a Symbol
Table

An S7/M7 program is created automatically for each programmable module as
acontainer for the software:

The following objects already exist in anew S7 program:
e Symbol table (“Symbols’ object)
* A “Blocks’ container for blocks with OB1 asthe first block

* A “SourceFiles’ container for programs in the form of source files

If you want to create Statement List, Function Block Diagram, or Ladder Logic
programs, select the existing “Blocks” object and then click the menu
command I nsert »[$7 Software > Block. In the submenu, you can select the
type of block you want to create (such as a data block, user-defined data type
(UDT), function, function block, organization block, or variable table (VAT)).

You can now open the (empty) block and start entering the Statement List,
Ladder Logic, or Function Block Diagram program. You will find more
information in the Satement List /232/, Ladder Logic /233/, and Function
Block Diagram /236/ Programming Manuals.

The“ System Data’ object (SDB) which may exist in auser program was
created by the system. You can open it to view its contents, but you cannot
make changes to it for reasons of consistency. It is used to make changes to the
configuration once you have loaded a program and to download the changesto
the programmabl e controller.

You can also use blocks from the standard libraries supplied with the software
to create user programs. You access the libraries using the menu command File
» Open. You will find more information on using standard libraries and
creating your own librariesin the online help.

If you want to create a source filein Statement List, select the “ Source Files’
or “Charts’ object in the S7 program and then select the menu command
Insert »[$7 Software»$ource File. In the submenu, you can select the source
file which matches your programming language. You can now open the empty
source file and start entering your program.

An (empty) symbol table (“ Symbols’ object) is created automatically when the
S7 program is created. When you open the symbol table, the “ Symbol Editor”
window opens displaying a symbol table where you can define symbols (refer
to Section 3.13.2 for more details).
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Inserting External You can create and edit source files with any ASCII editor. You can then
Source Files import these files into your project and compile them into executable blocks.
To insert an external source file, proceed as follows:

1. Select the “Source Files’ container to which you want to import the source
file.

2. Select the menu command Insert » External Source File.
3. Enter the source file namein the dialog box which appears.

The blocks created when the imported source file is compiled are stored in the
“Blocks’ container.
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3.7 Blocks

3.7.1 Comparison

The following table provides a comparison of the blocksin STEP 5 and
STEP 7. Thetable isintended to answer the question “Which STEP 7 block

should | use for which STEP 5 block?”

No Fixed Thistable is not to be interpreted as a fixed one-to-one set of assignments since
Assignment the new block environment makes additional programming options available.
The table entries are to be understood as a set of recommendations for starting
STEP 7 programming.
Table 3-2 Comparison of Blocks: STEP5/ STEP 7
STEP 5 Block STEP 7 Block Explanation
Organization block (OB) Organization blocks (OB) Interface to the operating system
Integrated specia OBs System functions (SFC) System functionsin STEP 7 replace

Function block (FB, FX)

System function blocks
(SFBs)

. Function (FC)

' Functions (FCs) in STEP 7 have the

the special organization blocks (STEP
5) that can be called in the user
program.

same properties as function blocksin
STEPS.

Program block (PB)

Function block (FB)

Program blocks correspond to the
function blocksin STEP 7. Function
blocksin STEP 7 have completely
new properties compared to blocksin
STEP 5 having the same name; thus,
they now provide new programming
options.

Note: During conversion, program
blocks are transformed into functions
(FCs).

Sequence block (SB)

There are no sequence blocksin
STEP7.

Data block (DB, DX)

Datablock DXO0, DBlinits
special function

Data block (DB)

| System data blocks (SDB)

(CPU parameter assignment)

8 Kbytes, in S7-400 up to 64 Kbytes).

In STEP 7 the data blocks are longer
thanin STEP 5 (in S7-300 up to

The new system data blocks contain
al the hardware configuration data,
including the CPU parameter
assignments, which determine the
program processing.

Comment blocks DK, DK X,
FK, FKX, PK

In STEP 7 there are no longer any
comment blocks. Comments are
contained in the respective block in
the offline database.
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3.7.2 Functions and Function Blocks

Functions (FCs)

Function Blocks
(FBs)

Functions (FCs) are logic blocks without a“memory”. The output parameters
contain the cal cul ated function values after the function is processed. It isthen
up to the user how the actual parameters are used and saved after the FC is
called.

Do not confuse functions with function blocks! In STEP 7 these are different
types of blocks.

Function blocks (FB) are logic blocks which do have a“memory.” The
memory isin the form of an instance data block which is associated with the
function, in which the actual parameters and static data of the function block
are stored.

Function blocks are used for applications such as programming controller
structures.

3.7.3 Data Blocks

3-18

Data blocks store the data for the user program. A distiction is made between
shared data blocks and instance data bl ocks, as explained in the following:

* Shared data blocks are not assigned to any particular block (asin STEP5).

* Instance data blocks are associated with a function block (FB) and contain,
in addition to the FB data, the data from multiple instances that may have
been defined.

Every data block can either be a shared data block or an instance data block.
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3.7.4  System Blocks

System Functions You do not have to program every function yourself. You can also program
(SFCs) and System  communication functions, for example, by using pre-configured blocks that are
Function Blocks available in the operating system on the CPUs. These are the following:
(SFBs) e System functions (SFCs), with properties like those of functions (FCs)

* System function blocks (SFBs), with properties like those of function

blocks (FBs).
System Data The previous discussion was centered around blocks containing programs or
Blocks (SDB) data from the user program. In addition to these blocks there are other blocks

containing settings such as modul e parameters or addresses. These are called
system data blocks (SDBs) and are created by special STEP 7 applications,
for example, when entering the hardware configuration or creating connection
tables.
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3.7.5

Distribution of
Organization

Organization Blocks

Organization blocks (OBs) form the interface between the operating system
and the user program. Different organization blocks carry out their own

specific tasks.

You assemble the STL user program for your S7 CPU from the organization

blocks (OBs) required for your automation solution.

Blocks
Table 3-3 Comparison of the OBsin S5 and S7
Function S5 S7

Main program Free cycle OB1 OB1

Interrupts Time-delay (delayed) OB6 OB20to OB23
interrupt
Time-of-day 0OB9 OB10to OB17
(clock-controlled)
interrupt
Hardware interrupts 0OB2to OB5 0OB40 to OB47
Process interrupts OB2to OB9 (1B 0) Replaced by hardware

interrupts

Cyclic (timed) OB10to OB18 OB30to OB38
interrupts
Multicomputing - OB60
interrupt

Startup Manual complete (cold) | OB21 (S5-115U) OB20 | OB100
restart (from S5-135V)
Manual (warm) restart | OB21 (from S5-135U) | OB101
Automatic (warm) 0oB22 0OB101
restart

Errors Error OB19to OB35 0OB121, OB122, OB80

to OB87

Other Processingin STOP 0B39 Omitted
mode
Background processing | — 0B90

3-20
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Error Handling

Error OBs

Error OBs are called if an error occurs during program execution. You can use

them to help program error reactions. If no error OB exists for a particular

error type, then the CPU goes into STOP maode.

Table 3-4 Error Handling in S5 and S7

From S5 to S7, Converter Manual
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Function S7

Calling ablock which is not loaded 0OB19 OB121

Timeout with direct accessto I/O modules 0B23 0OB122

Timeout updating the process image and the 0oB24 0OB122

IPC flags (interprocessor communication

flags)

Addressing error 0B25 0OB122

Cycle time exceeded 0OB26 OB80

Substitution error oB27 Omitted

Stop by operator 0B28 Omitted
(S5-135V)

Timeout with input byte IB 0 0oB28 0B85
(S5-155U)

Illegal instruction code ' 0B29 STOP
(S5-135V)

Timeout with direct accessto 1/Osin the 0B29 0OB122

extended address area (S5-155U)

Illegal parameter OB30 Omitted
(S5-135V)

Parity error or timeout accessing user memory . 0OB30 0OB122
(S5-155V)

Special function group error 0B31 Omitted

Load and transfer error with a data block 0B32 OB121

Collision of timed interrupts . 0OB33 0OB80

Controller error OoB34 Omitted
(S5-135V)

Error generating a data block OB34 SFC feedback
(S5-155V)

Communication error | OB35 OB84
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Troubleshooting in
S5 and S7

Exceeded Signal

Asin S5, you can also use the status word bits OV and OS to evaluate a report

of an exceeded signal. The difference in behavior in the two systems is minor.

For further information about the behavior of status bits with reference to
instructions, see the Statement List Programming Manual /232/.

Integrated Special
Functions

The interface between the user program and the system program in S5 CPUs
consists of accesses made to the operating system area and via special OBs.

In S7 CPUs, this interface has two new block types (“system functions’ and
“system function blocks”), in addition to the organization blocks.

System
Functions/System
Function Blocks

System functions (SFCs) and system function blocks (SFBs) are blocks
integrated in the CPU operating system which can be called in a STEP 7 user
program as needed. If an error occurs during processing of a system function

(SFC), this error can be evaluated in the user program with the aid of the
RET_VAL return value.

Table 3-5 Specia Functionsin S5 and S7
Function S5 Block Replacement in S7
Cycletime triggering 0OB31 SFC43 RE_TRIGR
Battery failure OB34 OB81 (Error reaction can be
programmed by user)
Access to condition code byte OB110 STEP 7 instruction:
L STWIT STW
Delete ACCU1-4 OB111 STEP 7 instruction sequence:
L 0; PUSH; PUSH; PUSH
Roll up ACCU OB112 Function not identical:
STEP 7 instruction: PUSH
Roll down ACCU OB113 Function not identical
STEP 7 instruction: POP
Disable al interrupts on/off 0OB120 SFC41 DIS AIRT
SFC42 EN_AIRT
Disable cyclic (timed) interrupts | OB121 SFC39DIS IRT
individually on/off SFC40EN IRT
Delay dl interrupts on/off 0OB122 SFCA41DIS AIRT
SFC42 EN_AIRT
Delay cyclic (timed) interrupts | OB123 SFC39DIS IRT
individually on/off SFC40 EN_IRT
Set/read CPU time 0OB150 SFCO SET_CLK

(continued on next page)

SFC1 READ_CLK

3-22

From S5 to S7, Converter Manual
A5E00261402-01




Software

Table 3-5 Specia Functionsin S5 and S7, continued
Function S5 Block Replacement in S7

Set/read time-controlled OB151 SFC28 SET_TINT
interrupt time SFC30 ACT_TINT

SFC31 QRY_TINT
Cycle statistics 0OB152 Local datain OB1
Counter loop OB160 - 163 STEP 7 instruction: LOOP

(S5-135U)
Variable timed loop 0OB160 SFC47 WAIT
(S5-115V)

Read block stack 0OB170 Omitted
Variable data block access 0B180 Omitted
Test data block 0B181 SFC24 TEST_DB
Copy dataarea OB182 | SFC20 BLKMOV
Transfer flags to data blocks 0OB190, OB192 SFC20 BLKMOV
Transfer data blocksto flag 0OB191, OB193 SFC20 BLKMOV
areas
Function_sfolr multi processor 0OB200 - 205 " Omitted
communication
Page access 0OB216 - 218 No page addressing in S7
Sign extension 0B220 S7 instruction: ITD
Set cycle monitoring time 0B221 Parameter assignment with S7
Restart cycle monitoring time 0B222 SFC43 RE_TRIGR
Compare startup types 0OB223 Multicomputing startup only for

same startup type
Transfer IPC flags in blocks 0B224 Omitted
Read word from the system 0B226 Omitted
program
Read CRC of the system 0oB227 Omitted
program
Read status information of a 0B228 | SFC51 RDSY SST
program processing level SFC6 RD_SINFO
Functions for handling blocks 0OB230 - 237 Communication with SFBs
Initialize shift register 0OB240 Omitted
Process shift register 0OB241 . Omitted
Delete shift register 0B242 Omitted
Contral: Initialize PID algorithm | OB250 Closed-loop control FBs: FB41 -
Control: Process PID algorithm | OB251 FB43

or SFB41 - SFB43
Transfer datablocks (DB/DX) | OB254, OB255 " Omitted
to DB RAM
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3.7.6 Block Representation during Conversion

Block Assighment .The block structure has been changed for S7. The figure below shows a
simplified example of ablock assignment for STEP 5 and STEP 7 resulting
from the conversion process.

STEP 5

OB FB PB SB DB

OB FC DB SDB FB
STEP 7

Figure 3-6 Blocks with Comparable Function in STEP 5 and STEP 7

Table 3-6 on the following page shows you how block calls are converted.
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Table 3-6 Block Typesin S5 and S7
S5 S7
OB Fixed User program Corresponding S7 OB Fixed numbers
numbers
OB Fixed Specia function Not convertible, must be reprogrammed with S7
numbers
PB 0to 255 User program FC blocks without parameters Number is proposed
FB/FX | Oto255 User program FC blocks with parameters whose | Number is proposed
names are retained
FB Fixed Integrated Loadable FCs contained in the Fixed numbers
numbers function blocks FBIlibl library which must be
loaded to the converted file before
compiling
FB/FX | Fixed names | Standard function blocks Loadable FCs contained in the Fixed numbers
FBIlibl library which must be
loaded to the converted file before
compiling
SB 0to 255 User program FC blocks without parameters Number is
(sequencers cannot be converted | Suggested
and must be created in S7
GRAPH.
DB 210 255 User data Shared data blocks (DBs) Number taken from
S5
DX 1to 255 User data Shared data blocks (DBs) Number from 256
onwardsis
suggested
DB1/ Data blocks with system If the blocks contain CPU-specific entries, the parameter
DX0 settings settings must be made with STEP 7. The converted

contents of DB1 and DXO0 are irrelevant and can be

deleted.

From S5 to S7, Converter Manual
A5E00261402-01

3-25




Software

3.8 System Settings

Converting DB1

The following tables show how the functions for the parametersin DB1 and

and DXO0 DXO0 (system settings) are made:
Table 3-7 Converting the System Settings from DB1
S5 Parameter Block How Implemented in S7
Startup delay Call SFC47 WAIT
IPC flags Set using global data communication, call

SFC60 GD_SND
SFC61 GD_RCV

Location of error code

System enters error messages in the diagnostic
buffer. Information about “Location of error code”
omitted

Replace number of integrated FBs
On-board analog inputs

| Omitted

Set in HWConfig using CPU properties

On-board interrupt

Set in HWConfig using CPU properties

On-board counter
Change priorities of OBs

. Setin HWConfig using CPU properties

Set in HWConfig using CPU properties

Output/disable process image

Call SFC27 UPDAT_PO

Read in/disable processimage

Call SFC26 UPDAT_PI

Retentive flags

Set in HWConfig using CPU properties

Retentive timers

Set in HWConfig using CPU properties

Retentive counters

Set in HWConfig using CPU properties

SINEC L1 Replaced by MPI bus (global data
communication)

SINEC L2 Set with HWConfig

Software protection In preparation

Clock parameters

Set in HWConfig using CPU properties or by
calling SFC28 SET_TINT

Assigning parameters to timed interrupt OBs

Set in HWConfig using CPU properties

Cycle time monitoring

Set in HWConfig using CPU properties
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Table 3-8

Converting the System Settings from DXO0

S5 Parameter Block

How Implemented in S7

Addressing error monitoring

Cdl OB121

Updating the IPC flags

Global data communication

Startup types after power on
Start synchronization in multiprocessor operation

Set in HWConfig using CPU properties
Set in HWConfig using CPU properties

Number of timer cells

Fixed CPU-specific value (for S7-300) or set in
HWConfig using CPU properties (for S7-400)

Error handling

Floating-point math

Cdl:
SFC36 MSK_FLT
SFC37 DMSK_FLT

Present

Process (hardware) interrupt triggering

Set in HWConfig using CPU properties

Timed (cyclic) interrupt processing mode

Cycle time monitoring
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3.9 Standard Functions

During conversion, the standard functions present in S5 are automatically
replaced by converted functions having the same functiondity. In S7, most of
these functions can be replaced by simplified command sequences, which

conserves memory and reduces the cycle time.

The standard functions are contained in the “ StdLib30" S7 library located in
the program container FBLib1.

For further information on working with libraries, refer to the online help.

3.9.1 Floating-Point Math

STEP5 STEP7 STEP5 STEP7

FB Name Number Name FB Name Number Name
GP:FPGP FC61 GP_FPGP GP:MUL FC65 GP_MUL
GP:GPFP FC62 'GP_GPFP GP:DIV FC66 GP_DIV
GP:ADD FC63 GP_ADD GP:VGL FC67 GP_VGL
GP:SUB FC64 GP_SUB RAD:GP FC68 RAD_GP
3.9.2 Signal Functions

STEP5 STEP7 STEP5 STEP7

FB Name Number Name FB Name Number Name
MLD:TG FC69 MLD_TG MLD:EZ FC75 MLD_EZ
MELD:TGZ FC70 MELD_TGZ MLD:ED FC76 MLD_ED
MLD:EZW FC71 MLD_EZW MLD:EZWK FC77 MLD_EZWK
MLD:EDW FC72 MLD_EDW MLD:EDWK FC78 MLD_EDWK
MLD:SAMW FC73 MLD_SAMW || MLD:EZK FC79 MLD_EZK
MLD:SAM FC74 MLD_SAM MLD:EDK FC80 MLD_EDK
3.9.3 Integrated Functions

STEP5 STEP7

FB Name Number Name
COD:B4 FC81 COD_B4
COD:16 FC82 COD_16
MUL:16 FC83 MUL_16
DIV:16 FC84 DIV_16
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3.94 Basic Functions
STEPS5 STEP 7 STEPS STEP7
FB Name Number Name FB Name Number Name
ADD:32 FC85 ADD_32 REG:LIFO FC93 REG_LIFO
SUB:32 FC86 SUB_32 DB:COPY FC94 DB_COPY
MUL:32 FC87 MUL_32 DB:COPY FC95 DB_COPY
DIV:32 FC88 DIV_32 RETTEN FC96 RETTEN
RAD:16 FC89 RAD_16 LADEN FC97 LADEN
REG:SCHB FC90 REG_SCHB COD:B8 FC98 COD_BS8
REG:SCHW FCI1 REG_SCHW COD:32 FC99 COD_32
REG:FIFO FC92 REG_FIFO
3.9.5 Analog Functions
STEPS5 STEP7 STEPS5 STEP7
FB Name Number Name FB Name Number Name
AE:460 FC100 AE_460 1 AE:466 FC106 AE_466 1
AE:460 FC101 AE_460 2 AE:466 FC107 AE_466 2
AE:463 FC102 AE 463 1 RLG:AA FC108 RLG_AA1l
AE:463 FC103 AE_463 2 RLG:AA FC109 RLG_AA2
AE:464 FC104 AE 464 1 PER:ET FC110 PER_ET1
AE:464 FC105 AE_464 2 PER:ET FC111 PER_ET2
3.9.6  Math Functions
STEP5 STEP7 STEPS5 STEP7
FB Name Number Name FB Name Number Name
SINE FC112 SINE ARCCOT FC119 ARCCOT
COSINE FC113 COSINE LN X FC120 LN_X
TANGENT FC114 TANGENT LG X FC121 LG_X
COTANG FC115 COTANG B LOG X FC122 B_LOG_X
ARCSIN FC116 ARCSIN ErX FC123 EHN
ARCCOS FC117 ARCCOS ZEHN”X FC124 ZEHN_H_N
ARCTAN FC118 ARCTAN A2M"AL FC125 A2 H Al
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3.10 Data Types

STEP 7 uses new data formats. The table below compares the different data
typesin S5 and S7:

Table 3-9 Data Typesin S5 and S7
Data Typesin Sb Data Typesin S7 Data Class
BOOL, BOOL, Elementary data types
BYTE, BYTE,
WORD, WORD,
DWORD, DWORD,
Integer, INT,
Double integer, DINT,
Floating point, REAL,
Time value, S5TIME,
- TIME, DATE; TIME_OF_DAY,
ASCII character CHAR
- DATE_AND_TIME, Complex data types
STRING,
ARRAY,
STRUCT
Timers, TIMER, Parameter types
Counters, COUNTER,
Blocks BLOCK_FC, BLOCK_FB,
BLOCK_DB, BLOCK_SDB,
- POINTER,
- ANY
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Table 3-10 Different Formats for Constantsin S5 and S7

Formatsin S5 Example Formatsin S7 Example

KB L KB 10 k8 L B#16# A

KF L KF10 k16 L 10

KH L KH FFFF 16# L 16# FFFF

KM L KM 1111111111111111 | 2# L 2411111111 11111111
KY L KY 10,12 B# L B#(10,12)

KT L KT 10.0 S5TIME# (S5T#) L S5TIME# 100ms

KC L KC30 C# L C#30

DH L DH FFFF FFFF 16# L DW#16# FFFF_FFFF
KS L KSWW " XX’ L' WW’

KG L KG +234 +09 Floating point L +2.34 E+08

Representation: S5 format

< Exponent - < Mantissa—

Repr.: Single format compl. with ANSI/IEEE

< Exponent - < Mantissa—

3130 24 23 22 0

3130 23 22 0

20
Exponent = value of exponent

SE = sign of the exponent

SM = sign of the mantissa

Range of values: 1.5x 10~39to0 1.7 x 1038

‘s 2., 20 23 \
Exponent = actual exponent + bias* (+127)

S = sign of the mantissa

Range of values: approx. 1.18 x 1038 t0 3.4 x
10+38

* Bias: Thisis an offset factor separating the exponents into positive and
negative areas. The value 127 in the exponent area corresponds to the value 0

in an absolute sense.

For further information about data types see the Satement List Programming

Manual /232/.
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3.11 Address Areas
3.11.1 Overview

Table 3-11 Addressesin S5 and S7

Address Areas Addressesin S5 Addressesin S7 Remark
Inputs | |
Outputs Q Q
1/0 PQG Pl for load commands | Shared I/O is not
PQ for transfer converted
commands
Bit memory (flag) area | F M
S M from M 256.0
(Converter)
“Scratchpad flags’ L Converted like flags
Timers T
Counters C C
Dataarea D... DB... Converted as shared
data addresses
System data RS, RT,RI, RJ - Not
Page area C - converted
Note on Data In S7 there are two data block registers: the DB register, which is
Addresses predominantly used for shared data blocks and the DI register, which is

preferred for instance DBs. For this reason there are also two types of data
addresses. The addresses DBX, DBB, DBW, and DBD are addresses of shared
data blocks; the addresses DIX, DIB, DIW, and DID are addresses of instance
DBs. During conversion, addresses of shared data blocks are used for the data
block addresses D, DB, DW, DD.

Also note how data blocks are converted (see Section 3.7.6).

i’i War ning
Be aware that the size and number areas for address areas and the number and
length of blocks for S7 al depend upon the CPU used. CPU performance
criteriaand ratings can be found in Section 2.2.1.
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3.11.2 New Addresses in S7: Local Data

Local Data in
STEP 7

Block Parameters

Static Local Data

Temporary Local
Data

Local datain STEP 7 are the data assigned to alogic block which are either
declared in its declaration section or in its variable declaration. Depending on
the block, they consist of formal parameters, static data, and temporary data.
Local data are usually addressed symbolically.

Block parameters of functions (FC) are handled like the block parametersin
S5: the block parameters represent pointers which point to the corresponding
actual parameter.

Block parameters of function blocks (FB) are stored like the static local datain
the instance data block.

Static local data can be used in every function block. They are defined in the
declaration section and stored in the instance data block.

Static local data, like data addresses in shared data blocks, retain their value
until they are overwritten by the program.

Generally, the static local data are only processed in the function block.
However, since they are stored in a data block, the local data can be accessed
in the user program at any time, as isthe case with variablesin a shared data
block.

Scratchpad flagsin STEP 5

In STEP 5, bit memory address areas are used to store data temporarily within
blocks. By common agreement, the flags 200 to 250 are reserved for temporary
storage. The management of scratchpad flags is completely up to the user.

Temporary local datain STEP 7

Temporary local data are storage areas for data that are only valid during block
processing. As soon as the block has been processed, these local datarelease
the used memory again. Each priority class hasits own local data stack. This
prevents intermediate results from being inadvertently overwritten by interrupt
programs.
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Using Temporary
Local Datain
STEP 7

Where Are
Temporary Local
Data Declared?

3-34

In STEP 7, temporary variables are used for the following three applications:
* Asintermediate storage for data from a user program.

This application is explained above and applies to functions (FCs), function
blocks (FBs), and organization blocks (OBS).

e Asmemory used for transferring operating system information to the user
program.

The information supplied by the operating system to the user program has a
special name: “start information.” This start information is exclusively
provided to the organization blocks (OBs) as an interface between the
operating system and the user program.

e Totransfer parametersin FCs.

You declare temporary local datawithin ablock. When you create a new
block, you declare symbolic names for the temporary variables at the
beginning and then use them within the block. Each priority class has 256
bytes available in the S7-300. A total of 16 Kbytes are available in the S7-400
which the user can divide among the priority classes when assigning
parameters to the CPU.
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(continued on next page)

CB/CW/CD,
LWGW/GD/CW/
CD,

TY GB/GW /GD/
CB/CW/CD,
TWGW/GD/CW/
CD

3.12 Instructions
The following table provides an overview of the instructions used. In addition,
it also shows which instructions can be converted. If the instructions are not
convertible, then other conversion options are indicated.
Table 3-12 Instructionsin S5 and in S7
Instruction Type S5 S7 Conversion Conversion
Option
Accumulator TAK, ENT, I, D, TAK, ENT, INC, yes -
instructions ADDBN, ADDKF, | DEC, +,
ADDDH
New in S7:
CAW, CAD, PUSH,
POP, LEAVE
Addressregister MA1, MBR, ABR, | New in S7: no Use address
instructions/ MAS,MAB, MSB, | | AR1, LAR2, register (AR1,
Register instructions MSA, MBA, MBS; TAR1, TAR2, AR2)
TSG, LRB, LRW, +AR1, +AR2,
LRD, TRB, TRW,
TRD CAR
Bit logicinstructions | A, AN, O, ON, A(, | A,AN, O,ON, A(, | yes -
O(y )1 O! Sl R! RB! O(l )1 O! Sa Ry =
RD=
TB, TBN, SU, RU | SET; A, SET; AN,
SET; S, SET; R
New in S7:
X, XN, X(, XN(,
FP, FN, NOT, SET,
CLR, SAVE
Timer instructions SP, SE, SD, SP, SE, SD, SS, SF, | yes -
SS/SSU, SF/SFD, FR,ST
FR, SEC
Counter instructions | CU/SSU, CD/SFD, | CU,CD, FR,SC yes -
FR, SEC
Load and transfer L, LD, LW, LDW, L,LC, T yes -
instructions TL PB, L QB, L PIB, L PIW,
LPW,LQW,TPB, | T poB, T POW
TOB, TPW, TQW PQ PQ
LY GB/GW/GD/ no Substitute by

accessto 1/O area
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Table 3-12 Instructions in S5 and in S7, continued
Instruction Type S5 S7 Conversion Conversion
Option
Integer math +F, —F, xF, :F, +D, +I, -, *1, /I, +D, yes -
instructions -D -D,*D, /D
New in S7:
MOD
Floating-point math +G, -G, xG, :G +R, R, *R, /R yes -
instructions
Comparison I=F, ><F, >F, <F, ==l, <>, >I, <I; yes -
instructions >=F, <=F, =D, >=|, <=|, ==D,
><D, D, <D, >=D, | <>D,>D, <D, >=D,
<=D, I=G, ><G, <=D, ==R, <>R,
>G, <G, >=G, <=G | >R, <R, >=R, <=R
Conversion CFW, CSw, CsD INVI, NEGI, yes -
instructions DEF, DED, DUF, NEGD, BTI, BTD,
DUD, GFD, FDG DTB, ITB, RND,
DTR
New in S7:
ITD, RND+,
RND—, TRUNC,
INVD, NEGR
Word logic AW, OW, XOW AW, OW, XOW yes -
instructions
New in S7:
AD, OD, XOD
Shift and rotate SLW, SLD, SRW, SLW, SLD, SRW, yes -
instructions SRD, SVW, SVD, SRD, SSI, SSD,
RLD, RRD RLD, RRD
New in S7:
RLDA, RRDA
Datablock G, CX OPN yes
Instructions G, GX SFC22 no Substitute by
calling SFC22
CREATE DB
New in S7:
CDB
(continued on next page) L DBLG, L DBNO,
L DILG, L DINO
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Table 3-12 Instructionsin S5 and in S7, continued
Instruction Type S5 S7 Conversion Conversion
Option
Logic control JU,JC,IN,JZ, P, | JU,JC,IN,JZ,JP, | yes -
instructions, jump M, JO, JOS, JUR | M, JO, JOS
New in S7:
JCN, JCB, JNB,
JBI, INBI, IMZ,
JPZ, JUO, LOOPR,
Ju
Block instructions JU, JC, DOU, CALL, BE, BEU, yes -
DOC, BE, BEU, BEC
BEC
Command output BAS, BAF New in S7: no Substitute by
instructions/ Master MCRA, MCRD, calling SFC26,
control relay MCR(, )MCR SFC27 or master
instructions control relay
instructions
Stop commands STPR, STS, STW SFC46 no Substitute by
calling SFC46
STP
Processing functions | DO <Formal - no Call of DB/ code
parameter> block must be
newly
programmed
DO FwW, DO DW Memory-indirect yes Recommendation:
addressing substitute with
register indirect
addressing
DORS Area-crossing no Must be
register-indirect substituted with
addressing indirect
addressing (see
Section 3.13.4)
Absolute memory LIR, TIR,LDI, TDI | — no Must be
addressing substituted with
indirect
addressing (see
Section 3.13.4)
Block transfers TNB, TNW, TXB, | SFC20 no Substitute by
TXW calling SFC20
BLKMOV
Interrupt commands | LIM, SIM, IAE, SFC39to 42 no Substitute by
RAE, IA, RA calling SFC39 -
(continued on next page) 42
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Table 3-12 Instructions in S5 and in S7, continued

Instruction Type S5 S7 Conversion Conversion
Option
Page commands ACR, TSC, TSG - no S7 has no page
access.

Math functions - ABS, COS, SIN, - -

TAN, ACOS,

ASIN, ATAN, EXP,

LN
Null instructions BLD xxx BLD xxx yes -

NOPO, NOP 1 NOPO, NOP 1
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3.13 Addressing

3.13.1 Absolute Addressing

The absolute addressing in S5 and S7 isidentical, with one exception:

In S7, datain data blocks are addressed in bytes; that is, word addressesin S5
are transformed into byte addresses by being multiplied by 2.

The following table shows the assignment during this conversion (data area
addressing:

S5 S7
DLO, 1,2, 3,...255 DBBO, 2,4, 6, ..510
DRO, 1, 2,3, ...255 DBB 1,3,5,7,..511
DWO, 1,2, 3,..255 DBWO, 2,4, 6, ...510
DDO, 1,23, ..254 DBDO, 2, 4, 6, ...508
D x.y DBX 2x.yfor8=<y=<15
DBX 2x+l).yforO=sy=<7

3.13.2 Symbolic Addressing

Symbols in STEP 5

Symbols in STEP 7

Shared Symbols

The symbolic addressing in S5 isaso used in S7. However, there are now new
options for creating and using the symbols. There are no differencesin
programming.

Symbols for STEP 5 programs are declared with the help of the symbol editor.
This editor generates an assignment list which allows you to use the symbols
defined there instead of absolute addresses.

In S7, symbols can be up to 24 characters long.

STEP 7 also has a symbol editor, but the assignment list (ZULI) is now known
asa“symbol table.” In it you can declare al shared symbols such asinputs,
outputs, bit memory (flags), and blocks.

When you assign symbols with the symbol editor, these are valid for a CPU
program.
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Local Symbols

When are Symbols
Declared?

Importing a
Symbol Table

3-40

Besides being able to declare symbols with the symbol editor, STEP 7 also
gives you the option of specifying local symbols for data addresses and for the
local data area when programming blocks.

If you assign symbols within a block instead of assigning them with the
symbol editor, then this symbol is only “valid” for the block concerned. In this
case the symbol is“local to the block.”

STEP 7 does not stipulate exactly when you have to specify your symbols.
When doing this you have the following two options:

*  Specify them before beginning to program

(Thisisrequired if the user program isinput incrementally; that is, if the
program syntax is checked after each lineis created.)

* Specify them after creating the user program but before compiling

(Thisisrequired if the user program isinput in free-edit mode; that is, if
the program is created as an ASCI| file (sourcefile).)

In S7, you have the option of creating and editing the symbol table with the
editor of your choice.

You can import tables that you created with another tool into your symbol table
and then edit them further. For example, the import function can be used to add
assignment lists created in STEP 5/ST after conversion.

The following data formats are available: *.SDF, *.ASC, *.DIF, and *.SEQ.
To import a symbol table, proceed as follows:

1. Open the S7 program containing the symbol table in the project window.
2. Double-click the“Symbols’ container to open the symbol table.

3. Select the menu command Symbol Table>[Import in the window
containing the symbol table. A dialog box is displayed.

4. Select the symbol table that you want to import in the dialog box and then
click the “Open” button.

5. Check over the data records in the symbol table and make any corrections
necessary.

6. Save and close the symbol table.

Note

A symbol tablein *.SEQ file format that was converted from S5 to S7 can no
longer be imported into S5. The file format *.DIF is recommended for
exchanging symbol tables between S5 and S7.

For further information on symbol tables, see the User Manual [231/.
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3.13.3 New Feature: Complete Addressing of Data Addresses

Example

Possible
Operations Using
Completely-
Addressed Data
Access

Complete addressing means that the data block is specified along with the data
address. Thiswas not possiblein S5.

Complete addressing can occur either absolutely or symbolically. Combining
absolute and symbolic addressing within one statement is not possible.

L DB100.DBW6
L DB_MOTOR.SPEED

DB_MOTOR isthe symbol for the data block DB100 and is defined in the
symbol table. MOTOR.SPEED is a data address that was declared in the data
block. This means that the symbolic name for the data address
(DB_MOTOR.SPEED) isjust as unique as the absolute address
(DB100.DBWS).

Completely addressed data access can only be done in connection with the
shared data block register (DB register). During complete addressing the STL
editor issues statements:

1. Open the data block viathe DB register (such as OPN DB100)
2. Accessthe data address (such asL DBW 6)

You have the option of using completely addressed access for all instructions
that are allowed for the data type in the data address being addressed.

Completely addressed data addresses can also be specified as block
parameters. Thisis strongly recommended sinceiit is possible for the data
block to be switched when it is called. Complete addressing ensures that the
correct data address is transferred from the correct data block.
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Dangers of “Partial
Addressing”

3-42

In principleit is possible to access data addresses in the same way asin
STEPS5 (“partial addressing”).

Example:

L DBW 6
L SPEED

In STEP 7 this may cause problems because STEP 7 changes the registers for
the S7-300/S7-400 CPU during various operations. In some cases the DB
number in the DB register will be overwritten.

The DB register may be overwritten in the following situations. Thus,
particular care must be taken here:

The DB register is overwritten during data access using complete
addressing.

If afunction block (FB) is called, then the data block register for the calling
block is overwritten.

After acall is made to afunction (FC) which transfers a parameter with a
complex data type (such as STRING, DATE_AND_TIME, ARRAY,
STRUCT, or UDT), the contents of the DB register for the calling block are
overwritten.

After you have assigned an actual parameter to an FC stored in a DB (such
as DB100.DBX0.1), STEP 7 opens the DB (DB100) in which the contents
of the DB register are overwritten.

After an FB has addressed an infout parameter with a complex data type
such as STRING, DATE_AND_TIME, ARRAY, STRUCT, or UDT,
STEP 7 usesthe DB register to access data. This step overwrites the
contents of the DB register.

After an FC has addressed a parameter (input, output or in/out) with a
complex data type (such as STRING, DATE_AND_TIME, ARRAY,
STRUCT, or UDT), STEP 7 usesthe DB register to access data. This step
overwrites the contents of the DB register.
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3.13.4 Indirect Addressing

Pointer Format in
STEP 5

Pointer Format in
STEP 7

Indirect addressing using the “DQO” function of S5 has been replaced in S7 by
the new indirect memory and register addressing commands.

In S5 the pointer for the indicated processing operation occupies one word.
The structure of the pointer is depicted in Figure 3-7:

15.. .10 9 8 7.. .0
Bit address| Byte address

15.. .8 7 .0

Word address/
Block number

Figure 3-7 Structure Pointer S5

In S7 there are two possible pointer formats, word and double-word.

15.. .8 7. .0
[ nnnn nnnn[nnnn nnnn|

Bits 0 to 15 (nnnn nnnn nnnn nnnn): Number (area O to 65 535) of a timer (T),
a counter (C), data block (DB), function (FC), or function block (FB)

Figure 3-8 Pointer in Word Format for Memory-Indirect Addressing

31.. .24 23.. .16 15.. .8 7. .0
[a000 Orrr [0000 O bbb| bbbb bbbb|bbbb b xxx|

Bit 31 = 0 (@) means area-internal addressing
Bit 31 = 1 (a) means area-crossing addressing

Bit 24, 25, 26 (rrr): Area ID for area-crossing addressing

Bits 3 to 18 (bbbb bbbb bbbb bbbb): Number (area 0 to 65 535) of the
addressed byte

Bits 0 to 2 (xxx): Number (area 0 to 7) of the addressed bit

Figure 3-9 Pointer in Double Word Format for Memory-Indirect and Register
Indirect Addressing
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Memory-Indirect

Memory-indirect addressing corresponds to indirect addressing in S5. During

Addressing memory-indirect addressing, the address specifies the address of the value that
will process the instruction. The address consists of the following parts:
* Anaddressidentifier, such as“1B” for “input byte’, and
* A word that contains the number of atimer (T), a counter (C), a data block
(DB), afunction (FC) or afunction block (FB), or
* A doubleword that specifies the exact address of avalue within the
memory areaindicated by the address identifier.
The address uses the pointer to indirectly indicate the address of the value or
the number. Thisword or double word can be located in one of the following
aress:.
* Bit memory (flag) (M)
* Datablock (DB)
* Instance data block (DI)
* Locd data L
The advantage of memory-indirect addressing is that you can dynamically
modify the address of the statement when editing the program.
Examples
The following examples show how you can work with a pointer in word
format:
STL S5 STL S7 Explanation
L KB 5 L +5 Load the value 5 as an integer in ACCU 1.
T FW2 T MV 2 Transfer the contents of ACCU 1 into the memory word
DO FW 2 MW2.
LTO LT[MN2]] L oad the time value of thetimer T 5.
The following two examples show how you can work with a pointer in
double-word format.
STL S5 STL S7 Explanation
L KB 8 L P#8.7 Load 240000 0000 0000 0000 0000 0000 0100 0111 (binary
T FY 3 T MD 2 value) in ACCU 1 (S7).
L KB 7 Save the address 8.7 in the memory word FW 2 (S5) /
T FY 2 memory double word MD 2 (S7).
DO FW 2
Al 0.0 Al [M 2] The controller queriestheinput | 8.7 and assignsits signal
DO FW 2 state to the output Q 8.7.
= Q0.0 = Q[M 2]

3-44
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Using the Correct
Sequence Syntax

Register-Indirect
Addressing

STL S5 STL S7 Explanation

L KB 8 L P#8.0 Load 2#0000 0000 0000 0000 0000 0000 0100 0000 (binary

DO FW 2 T MD2 value) in ACCU 1 (S7).

DO FW 2 Save the address 8 in memory word FW 2 (S5) / memory

LIBO L 1B [M2] double word MD 2 (S7).

DO FW 2

T FWO T MV [ MD2] The controller loads input byte IB 8 and transfers the
contents to memory word FW 8 (MW 8in STEP 7).

When working with a memory-indirect address that is stored in the memory
area of the data block, you must first open the data block by using the “ Open
datablock” instruction (OPN). After this, you can use the data word or data
double word as the indirect address, as shown in the following example:

OPN DB10
L IB [DBD 20]

When accessing a byte, word, or double word, first make sure that the bit
number of the pointer is*0.”

In STEP 7, the address registers AR1 and AR2 are used for indirect
addressing.

With indirect addressing, the address specifies the memory location of the
value that will process the instruction. The address consists of the following
two parts:

¢ Anaddressidentifier

* An addressregister and a pointer for indicating the offset added to the
content of the address register in order to determine the exact address that
theinstruction is to process. The pointer isindicated by P#Byte.Bit.

The address pointsindirectly to the address of the value. It does this by using
the address register plus the offset.

An instruction that uses area-internal, register-indirect addressing does not
change the value in the address register.

For further information, see the Satement List Programming Manual /232/.
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Part 2. Converting Programs

Procedure

Preparing for Conversion
Conversion

Editing the Converted Program

Compiling

Application Example
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Procedure 4

The programming of S7in STL islargely compatible with S5 STL. Similarly,
programming Ladder in S7 is compatible to S5 LAD and programming FBD in
S7 iscompatibleto S5 CSF. Thus, if you are an S5 user and want to use
existing programsin S7, this change is made much easier for you. You can
base the new system on your tried and tested S5 programs and convert them to
S7 programs.

How to Proceed Thefollowing list tells you how to convert your S5 program and lists the
sections where you will find the required information.

Thelist isintended as an example and as a guideline (individual steps can also
be skipped).
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4.1 Analyzing the S5 System

Functionality of
the Modules
(see Chapter 2)

System Settings
(see Section 3.8)

Range of
Instructions
(see Section 3.12)

Standard Software
(see Section 3.9)

Special Functions
(see Table 3-5)

Before you convert your S5 program you should clarify the following
questions:

How can the functionality of the modules used in your S5 program be achieved
in S7? Can your S5 modules be used in S7 with the help of adapter or interface
modules? Can your S5 modules be replaced with S7 modules?

How can the required system settings be implemented in S7?

How can the range of instructions used by the S5 CPU be implemented using
your S7 CPU?

If individual instructions cannot be converted, a message is output indicating
the corresponding program sections and the instructions must be
reprogrammed manually.

Do the S5 standard function blocks called in the program to be converted also
exist asfunctionsin S7?

The S7 Standard software supplied includes the standard software packages
already converted for basic functions, floating-point math, integrated
functions, signal functions, and math functions.

Can integrated specia functions used in S5 programs be replaced?
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Which Parts of In general, not all the parts of a program can be converted. Considering the
Your Program following points will help you decide whether to convert your S5 program or
Should be torecreateitin S7.

Reprogrammed in

* Programs only containing digital and binary logic operations do not need to
be revised.

* Absolute addresses cannot be addressed in S7. The corresponding
instructions (such as LIR, TIR, etc.) are not converted. If a program
frequently works with absolute addresses, it is agood idea to rewrite these
parts of the program or, if necessary, the entire program.

S7?

* Processing functions (such as DO FW, DO DW) are partially converted;
however, in this case you can save memory by reprogramming the
functionsin S7. This functionality can be obtained with indirect addressing.

* The parameter values of block calls must be always be checked and
adapted since the actual parameters used are transferred during conversion
without being changed.
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4.2 Creating an S7 Project

Creating a Project
with the STEP 7
Wizard

Creating a
Program Manually

STEP 7 provides you with the following two options for creating a project:

The STEP 7 wizard helps you create a STEP 7 program quickly with the CPU
you want to use. After completing this step, you can start programming.

In addition, you have the option of creating your project manually. The
procedure for thisis described in Section 3.3.1.

4.3 Defining Hardware

Defining Hardware

Address Allocation

Making System
Settings

Specifying
Retentive Behavior

At thispoint it isagood idea to configure the hardware since data are
determined in HWConfig that can be then be used to prepare for conversion.

However, if you do not want to configure your hardware yet, you can still do it
later.

The information found in Chapter 2 (“Hardware”) will help you select the S7
or S5 modules required for your configuration and fill out the hardware
configuration table (see Section 3.4).

The address allocation for the modules is done automatically by HWConfig.
This means that you can already use the addresses during conversion.

When assigning parameters to the CPU in HWConfig you can aso make
system settings which were created in DB1/DXO0 in S5 or by system utilities
(see Section 3.4).

The retentive behavior can also be set in the parameter datain the CPU. The
retentive behavior is, however, dependent on the battery backup (see
Section 3.4).
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Preparing for Conversion

Overview

Providing the required files (see Section 5.1)

Program file <Name>ST.S5D

Cross-reference list <Name>XR.INI

Optional assignment list
<Name>Z0.SEQ

Checking addresses
(see Section 5.2)

Number of addresses
Number of blocks

Preparing the S5 program
(see Section 5.3)

Evaluate and delete the
datablocks DB1/ DX0
Remove calls from the
integrated blocks

Remove access to the

system data area

Adapt the address areas

Assign macros to non-convertible
program parts

Delete data blocks without
structure down to one data word

Creating macros
(see Section 5.4)

Command macros
Organization block (OB) macros
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Preparing for Conversion

5.1 Providing the Required Files

Optional
Requirement

Procedure

5-2

The following data are required as the basis for converting your S5 program:
e Program file <Name> ST.S5D and
* Cross-reference list <Name> XR.INI

The cross-reference list is required when converting in order to retain the
program structure and call hierarchy of the S5 program.

If you want to use symbolic hames in your program instead of absolute
addresses, you also require the following data to generate the converted
assignment list:

e S5assignment list <Name> Z0.SEQ.

To prepare the conversion, proceed as follows:

1. Create acurrent cross-reference list for your S5 program using the S5
software.

2. Copy your STEP 5 program file, the corresponding cross-reference list and,
if necessary, the assignment list into a DOS directory.
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Functions of the

Adapting the

Checking Addresses

It may be necessary to adapt the converted program to the S7 CPU being used.

To gain an overview of the range of functions of the S7 CPU, proceed as
follows:

1
2.

Determine the S7 CPU that you want to use.

Find this S7 CPU in the performance specifications tablesin Section 2.2.1
and compare the following two specifications:

Number of addresses

Number of blocks

with the addresses and blocks to be used,

or

Open the SIMATIC Manager.
Select the S7 CPU in the online view of the project structure.

Use the menu command PLC » Module Information to open a dialog box
which includes, among other things, the following information:

In the “General” tab you can identify the CPU type, obtain information on
the memory configuration, and read the size of the available address areas.

Inthe“Blocks’ tab there isinformation on the available blocks. This
includes the maximum number and length of the blocks types, aswell asall
OBs, SFBs, and SFCs present on the CPU.

To adapt the STL program being converted so that it can run on the CPU,
check it for the permitted number of blocks and addresses, and modify as
necessary.
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5.3

Preparing the S5 Program

Before actually converting your STEP 5 program, you can prepare it for its
future use asa STEP 7 program. (However, you do not have to do thisfirst; all
necessary corrections can also be made in the STEP 7 source file after the
conversion.) Thisinitial adaptation will reduce the number of error messages
and warnings occurring during conversion.

For example, you can make the following adaptations to the STEP 5 program
before proceeding with the conversion:

Evaluate system settings in the data blocks with the program properties
DB1 or DXO. After this, you can delete DB1 and DXO.

Remove al calls from integrated blocks or accesses to the system data areg;
this functionality can be achieved by assigning parametersto the S7 CPU.

Adapt all input, output, and peripheral address areas to the (new) module
addresses by using the STEP 5 function “Rewire.” (When doing this, you
should make sure that the STEP 5 address area is not exceeded; otherwise,
an error will be reported during the first cycle of the conversion process. If
this occurs, these instructions will not be converted.)

Delete all repeated non-convertible parts of the program until there is only
one “unique” STEP 5 instruction for each part of the program. This
“unique” instruction can be assigned a macro to replace the part of the
program (see Section 5.4)

If your program contains very many (and long) data blocks having no
structure (such as those used as data buffers), you can del ete the data words
in these data blocks until only one data word remains. After converting but
before compiling, you can program the contents of these data blocks in the
source file by using an array declaration, such as buffer: ARRAY [1..256]
of WORD.

With the converter you can not only convert complete programs but also
individual program blocks.
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5.4 Creating Macros

Uses of Macros

Macro Functions

When converting, you can define macros for the following:
* S5instructionsthat cannot be automatically converted and

* S5instructions that you want to convert differently from the standard
conversion.

Macros can be useful if your program contains many S5 instructions which
correspond to the characteristics listed above.

Macros can replace the following:
* S5instructions
* S5 organization blocks (OBs)

The macros are saved for the SIMATIC instruction set in the STSSCAPA.MAC
file and for the international instruction set in the STSSCAPB.MAC file. If you
work with both instruction sets, you must specify the macros for each file. A
distinction is made between instruction macros and OB macros. You can create
256 instruction macros and 256 OB macros.
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Preparing for Conversion

54.1 Instruction Macros

Instruction macros must be structured as follows:
$MACRO <S5 instruction>

S7 instruction sequence
$ENDMVACRO

When defining amacro, enter the complete statement (instruction and absolute
address) for <S5 instruction>.

The table below shows a macro for the statement G DB 0, which is used to set
up data blocksin S5. The length (in words) of the data block to be set up isin
ACCU 1. In S7, the function is realized using the system function SFC22
CREAT_DB. The length of the data block must be converted into bytes.

Table 5-1 Example of an Instruction Macro

Macro S5 S/
$MACRO G DB 0 //Replaces instruction L Const ant L Constant;
/Ifor setting up a DB DO FW 100
SLW 1 // Nunber of words GDBO SLW 1;
/linto number of bytes T MV 102:
T MV102 CALL SFC22(
CALL SFC 22( //Call SFC CREAT_DB LOVLIMT = MV 100,
LOVLIMT = MA100, WP_LIMT := MW 100,
UP_L| MT = MN].OO, COUNT = MNlOZ,
COUNT - = MV 102, RET_VAL = MW 106,
RET_VAL = MV 1086, DB_NUMBER = MV 104);
DB_NUMBER = M\ 104) ;
$ENDVACRO
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542 OB Macros

Due to the differences in the organization blocks between S5 and S7 it may be
advisable to control the conversion of your instructions with S5 OBs yourself.
In this case, OB macros must be structured as follows:

$OBCALL: <Nunber of the OB>
CALL <S7 system function>;
$ENDMACRO

If an instruction with the address OB x is found in the S5 sourcefile, this
instruction is replaced by the defined macro instructions. Exceptions to this are
the FB callsthat use OBs asformal parameters.

Table 5-2 Example of an OB Macro

Notes on Creating
OBs

Macro S5 S7
$OBCALL: 31 /I Repl aces instructions JU OB 31 CALL SFC43;
//with OB31
CALL SFC 43;
$ENDVACRO

The functions of the organization blocksin S5 are different from those of the
OBsin S7. OBsthat cannot be converted automatically must be replaced by
the following:

* OBswith adifferent range of functions

* New S7 instructions, or

e System settings which are defined when assigning the hardware parameters
For detailed information about replacing S5 OBs, see Section 3.7.5.

Note

There is no check to determine whether amacro is defined twice. If this
happens to be the case, then the first macro defined is used. There is no check
to determine whether the specified S7 instruction sequence is correct. Make
sure that keywords and special characters (colon) are correctly written.
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Preparing for Conversion

5.4.3 Editing Macros

Macros are created as follows:

1. Start the S5/S7 Converter by clicking the “ Start” button in the Windows 95
taskbar and selecting Simatic/STEP 7/Convert S5files.

2. Select the menu command Edit » Replace M acro (There must be no
program file open!).

Result: The STSS5CAPB.MAC fileis opened.

3. Enter the macros as described above and save the file with the menu
command File» Save.

4. Closethe file with the menu command File» Close.

Result: The STS5CAPB.MAC fileisclosed. The macros are valid the next
time you start a conversion run.

Converting S5 Files - [s7u5capB.mac] !ﬂ

File Edit View Help

2| o (x| € Bf %

$MACRO: G DBO A
SLW 1; _,
T MW 102;
CALL SFC 22(
LOW_LIMIT = MW 100,
UP_LIMIT = MW 100,
COUNT = MW 102,
RET_VAL = MW 106,
DB_NUMBER = MW 104);
$ENDMACRO v
|« >
Press F1 for help. | 12 [ ] ‘

Figure 5-1 Macro in the Window “ Converting S5 Files’
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Conversion 6

6.1 Starting the Conversion

Prior Before you start to convert programs, make sure that the S5 file you want to
Requirements convert, the cross-reference list and, if necessary, the assignment list are in the
same directory (see Section 5.1).

Starting the S5/S7 After you have installed the STEP 7 software on your programming device,
Converter start the S5/S7 Converter using the “ Start” button in the taskbar of
Windows 95.

e Click onthe entry “Simatic/STEP 7/Convert S5 files’.
The S5/S7 Converter then displays the following initial screen:

E Converting S5 Files
File Edit View Help

Sl 2| [x] [e] =] ]|

Press F1 for help. [ ] I

Figure 6-1 Initial Screen of the S5/S7 Converter
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Selecting a
Program File

Changing the
Target File Names

Assighment
No. —> New No.

6-2

To select aprogram file, proceed as follows:

1. Select the menu command File» Open.

2. Select the drive and the directory containing the files to be converted.

3. Select thefileto be converted and click “OK” to confirm your selection.

Result: The S5/S7 Converter displays the source and target files and an
assignment of the old and new block numbers.

The figure below shows the dialog box “ Converting S5 Files
[<Test>ST.S5D]".

Converting S5 Files - [Test@@st.s5d] !ﬂ
File Edit View Help

N E PR PE P

S5 File: D:\S5CONVAS5_PROGR\TEST@@ST.S5D
XRF File: D:\S5CONVAS5_PROGR\TEST@@R.INI
STL File: | DAS5CONVAS7_PROGR\TEST@@AC.AWL
Error File: | D:\S5CONVAS7_PROGR\TEST@@AF.SEQ
S5 Assignment List: | D:\S5CONVAS5_PROGR\TEST@@Z0.SEQ
Converted Assignment List: | D:\S5CONV\S7_PROGR\TEST@@S7.SEQ
No.  Name Std. New No.
FB242 MUL16  * FC83 |a
FB243 DIV:16 * -FC84 [
FX3  Check -FC5 _Cancel |
FX100 STANDARD -FCB
0B1 -0B1
0oB21 -0B101 || __Help |
PB1 FC7 [
SRB1 -EC8
Press F1 for help. \ [ ‘

Figure 6-2 “Converting S5 Files — [<Test>ST.S5D]” Dialog Box

If required, you can modify the names of the target files“ STL File”, “Error
File’” and “ Converted Assignment List” proposed by the software. This may be
necessary if the editor with which you want to process the converted files
requires certain name conventions (for example TEST.TXT).

To change the name of afile, proceed asfollows:
1. Click the text box with the path name of the target file you want to modify.
2. Modify the text as required.

The software proposes new numbers for the blocks to be converted and
displays them in the dialog box “ Converting S5 Files [<Test>ST.S5D]”. If you
want to assign different numbers, proceed as follows:

1. Double-click the block number you want to modify.

2. Enter the new number in the “New Block Number” dialog box and click
the “OK” button to confirm your entry.
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S5 Standard
Function Blocks

Starting the
Conversion

If your S5 program contains standard function blocks (SFBs), these are marked
by an asterisk in the “ Std.” column.

By clicking on the “ Start” button, you start the conversion. The conversion
consists of two conversion runs and the conversion of the assignment list.

In the first conversion run, the S5 program is converted into an S5 source file
with al blocks and comments.

Convert File

‘ Status:  1strun ‘

Files:

STEP 5 File DA\ \NTEST@@ST.S5D

Block: SB 39

Statistics: Total Block
Lines: 750 389
Warnings: 12 6
Errors: 0 0

Figure 6-3 First Conversion Run

In the second run, the S5 source file is converted to the STL source file with
the new block types, block numbers, and S7 syntax.
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Converting the The symbolsin the S5 assignment list are converted into a form which can be
Assignment List imported by the Symbol Editor.
Convert File

‘ Status:  Assignment List ‘

Files:

STL D:\.\TEST@@S7.SEQ
Block:

Statistics: Total Block
Lines: 640 640
Warnings: 8 0
Errors: 0 0

Figure 6-4 Converting the Assignment List
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6.2 Generated Files

During conversion, the S5/S7 convertor generates the following files:

From S5 to S7, Converter Manual
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The file <Name>A0.SEQ:

Thisfileis generated during the first conversion run. It contains the file
<Name>ST.S5D in ASCII form.

Thefile <Name>AC.AWL:

Thisfileis generated during the second conversion run. It containsthe STL
program. Any messages resulting from incorrect macro definitions
originate from this run.

Thefile <Name>S7.SEQ:

Thisfileis generated from the conversion of the assignment list. It contains
the converted assignment list in aform suitable for importing with the
Symbol Editor.

The error file <Name>AF.SEQ:

Thisfileis displayed in the upper list box in the “Converting S5 Files’
window and contains the errors and warnings in the converted program.
These messages are generated during both conversion runs and also during
conversion of the assignment list.
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After the conversion runs are completed, a dialog box displays the total
number of errors and warnings made in the converted program.

Converting S5 Files - [012625st.s5d]
File Edit View Help

EEEPRORE s

C:\S5CONV\S5_PROGR\TEST@@AF.SEQ

Warning in Line 169 STEP 5 ASCII File:

** B 16, rel. Addr. OH : Preheader not available *** S7US5CAPX
Warning in Line 169 STEP 5 ASCII File:

*** B 185, rel. Addr. OH : Output not allowed (product no.)

** Error in Line 7060 (PB 211): Block not available Conversion complete

CALL FB 180; |
*** Error in Line 12270 (SB  38): Block not availab Errors: 3
oy CALLFB 16; _ Warnings: 2

Error in Line 13459 (SB  40): Block not availabl

CALL FB 16;

D:\S5CONV\S5_PROGR\TEST@@a0.seq

#FB99
#N FILL
DB (®).
Press F1 for help. | | ‘

Figure 6-5 Messages When Converting
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Localizing Errors In the lower list box in the window you can display the location in the file at
which the error occurred.

Messages are output in the STL sourcefile at the points in the program at
which errors were detected. Thisfile also contains warnings or indications that

problems might occur (for example, due to changesin the instruction
semantics).

Printing Messages Select the menu command File» Print to print out the message files you
require.

Print
Printer:  Standard printer (HP LaserJet 4Si MX)
Setup... I

— Print

Block Assignment:
Error List:

S5 ASCII File:
STL Source File:

SN

S5 Assignment List:

Converted Assignment List:

AN

Macros:

Print Quality: |EE0[0Ks]e]i ﬂ
OK I Cancel Help

Figure 6-6 “Print” Dialog Box
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The messages generated during conversion consist of error messages and
warnings. To analyze these messages, proceed as follows:

Display the file containing the error in the lower list box of the “Messages”

6.3 Interpreting Messages
Analyzing
Messages
1
window.

Error Messages

The meaning of the messages can be found in the online help.

Correct the error as suggested under “ Remedy.”

Error messages are displayed if parts of the S5 program cannot be converted

and are only included as comments in the S7 program. The table below lists all
the error messages, their meaning, and possible remedies.

References to
Rules

Table 6-1

Error Messages, Meaning, and Remedy

Chapter 3 (Software) contains the rules for converting S5 programs to S7. Here
you can also find further references to possible error sources and assistance
when subsequently editing the STL program.

Error Message

Source

Meaning

Remedy

Absolute parameter does not
match address

1st run

Wrong address ID

Check the instruction

Bit accessto T/Cisnolonger |2ndrun | S5 program contains bit accessto | Check the STL program
alowed (please check) timers and counters
Block not available Istrun | Caled block (FB, FX) missing or | Check the program structure
block is shown in the block list but
it does not exist in the program file
2nd run | Block is called that does not exist | Check whether the cross-reference
in the program file list was specified, or check the
program structure
CALL OB isnot allowed 2ndrun | Calling OBsisnot adlowedin S7 | If necessary, use the statement
CALL SFC
CALL SFC xy generating, 2nd run | Parameters for SFC missing Complete the SFC parameter list
please extend parameter list
Command in block not 1strun | For example, jump within a Check the instruction
allowed program block
Comment too long 1strun | Errorin S5file Check the program file
Conversion error 2nd run | Bl without constant Include a constant with the load
instruction
Directory not available 1strun | Program file does not contain any | Check the program file
blocks
Error in macro file. Macroxy | 2nd run | Macro error Check the macro instruction
ignored
Error in parameter 1strun | Error in the S5 program Check the program file

6-8
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Table 6-1 Error Messages, Meaning, and Remedy
Error Message Source Meaning Remedy
File not found general | Selected file does not exist Check the program file
Invalid MC5 code was 1st run | Conversion of an older S5 None
converted instruction
Invalid operator 1st run | Operator in S5 file not known or Replace the operator with the
cannot be converted appropriate S7 instruction
Invalid operator, may be 2nd run | The operator cannot be loaded into | You may have to use the specified
replaced by the instruction S7inthisform instruction
\"L P# formal parameter\”
Jump label cannot be 2nd run | JUR instruction exceeds block Correct the error in the S5 program
generated limit
Label invalid 1st run | Jump label containsinvalid Check the S5 file
characters
Label undefined Ist run | Jump label not defined in the Check the S5 file
preheader
Memory overflow in 1st run | Not enough main memory Delete files you no longer require
programming device (space in the main memory
problem)
No access rights general | Fileisread-only Clear the read-only attribute
No block name given 1st run | Block name consists of only Enter a block name
blanks
Undefined command 1strun | Invalid MC5/STL instruction Correct the S5 program file
2nd run | Instruction does not exist in S7 Edit a macro or replace the
instruction with the appropriate S7
instruction sequence
Undefined formal parameter Ist run | More parameters than in calling Check the S5 program file
block
Write error on diskette general | Fileisread-only or thereisno Clear the read-only attribute or
space on the diskette delete unnecessary data
Wrong address 1st run | Address does not match instruction | Check the S5 source file
2nd run | Address does not match instruction | Modify the STL file
Wrong comment length 1strun | Errorin S5file Check the program file
Wrong nesting depth Ist run | End of bracketed expression Check the nesting levels, correct
incorrect the programming error
Wrong number of parameters | 1strun | Error in the S5 program Check the program file
Wrong parameter type 1st run | Error in the S5 program Check the program file
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Warnings Warnings are displayed if parts of the S5 program are converted but should be
checked once more.
Table 6-2 Warnings, Meaning, and Remedy
Warning Source Meaning Remedy
ID only influences Accu 1-L, |2ndrun | S7 accumulators extended to Check the consequences of an
now whole Accu 1 32 bits indirect
INCREMENT/DECREMENT
instruction in the STL program
If S5 115U, then change to 2nd run | The startup OB21in S5is If the S5 program ran on an
OB 100 automatically converted to OB101 | S5-115U, you have to change
0OB101 to OB100
Jump instruction after EDIT 2nd run | An EDIT instruction with JU Replace the instruction in the STL
cannot be compiled cannot be converted automatically | file by JL and check the jump
Note block numbersmay be | 2nd run | Anindirect block call does not Change the logic in S5 or use fixed
changed take into account new block block calls
numbers (number is fetched from
corresponding memory word or
data word)
OB 23 and OB 24 havebeen | 2nd run | OB 23 and OB 24 are both Put the contents of OBs 23 and 24
converted to OB 122 replaced by OB 122 in S7 into OB 122 and delete the other
OB 122
OB was interpreted asOB 34 | 2nd run | Depending on the CPU used, the | Check whether this OB matches
from S5-115U OB 34 can have different your program
meanings
Output not allowed 1strun | GRAPH 5 blocks cannot be You may have to insert a
(GRAPHS5 block) converted GRAPH 7 block
Output not allowed 1strun | S5 standard function block must None
(product no.) be replaced by an S7 FC
Please check time interval 2nd run | Time intervals can be more Adjust thetimeinterval using the
Settings precisely set in S7 than in S function “Hardware
Configuration”
Please observe different STOP | 2nd run | No distinction has been made Check the program file
commands between STP, STS, and STW
Preheader not available 1strun | For FBs and FXsthe jump label Check whether the preheaders
identifiers are missing, for DBs exist in another file
and DXs the data formats are
missing
RLO s set 2nd run | With the S5 instructions SU and If necessary, insert the instruction
RU the RLO issetin S7 CLEAR
S5 screen DB wasnot usedto | 1strun | MASK isin DWO and DW1 Assign parameters to the
assign parameters to S7 programmable controller using
STEP7
System preferences cannot be | 2nd run | DB and DX will be converted but | Make the system settings using the

set by the S5/S7 Converter

do not have the same meaning as
in S5

configuration table
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Editing the Converted Program 7

Preparing to Edit The following preparations are necessary to edit the STL source file generated
during conversion:

e Makeaprintout of the messages generated during conversion.

* Create an S7 program in aproject in the SIMATIC Manager, if you have
not already done so.

* Import the STL source file program into the “ Source Files’” container of
this S7 program, using the menu command I nsert » External Source File,

e Open the converted file.

Editing the File To edit the generated STL source file, we recommend the following procedure:

* Work through the program in interactive mode and modify or supplement
the S5 instructions and organization blocks that were not converted based
on the warnings (see Part 1).
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7.1 Address Changes

Usually, input and output modules are affected by address changes. The
addresses for these modules can be found in HWConfig.

7.1.1  Options for Changing Addresses

Rewiring in S5

Rewiring in S7

Changing
Addresses in the
S7 Source File

Generating a New
(Symbolically
Addressed) S7
Source File

Prerequisite

Before converting you can use the “Rewire” function to adapt the addresses of
individual addressesin S5 to the new addressesin S7.

The SIMATIC Manager contains a function for automatically rewiring blocks
generated from your source file.

To rewire blocks, proceed as follows:
1. Select the blocksin your program to be rewired in the SIMATIC Manager.

2. Open the table used for rewiring by selecting the menu command
Options» Rewire.

3. Enter the old and new addresses for each address in the table and then save
them.

The blocks now contain the changed addresses.

In your program, adapt access to inputs and outputs as well as direct 1/0 access
to the new module addressesin S7.

In the S7 source file you can easily make changes to the absol ute addresses by
selecting the menu command Edit » Replace.

Caution: If the old and new address areas overlap, then unintended changes can
occur.

If you want to use symbolic addressing, you can also use the symbol table to
do the rewiring.

Before rewiring, you must already have a compiled program that is error-free
and a symbol table that contains all the symbols necessary for modifying the
absolute addresses.
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Procedure To change the addresses, proceed as follows:

1. Open ablock containing addresses to be changed. Select the option
“Symbolic Representation” in the “Editor” tab of the dialog box opened
with the menu command Options» Customize.

Repeat this procedure for all blocks containing addresses that you wish to
change.

2. Generate a source file from the blocks by selecting the menu command File
» Generate Source File. The blocks can be selected in adialog box after
you have entered the name of the sourcefile.

When creating a sequence of blocks, remember to take the call hierarchy into
account. Asarule, called blocks must aready exist. This means that they must
be entered in the source file in front of the blocks from which they are called.

Result: The source file generated contains the instructions with symbolic
addressing.

3. Now you can carry out the rewiring in the symbol table. Replace the
changed S5 addresses with the new S7 addresses.

4. Oncethe sourcefileis compiled, the blocks contain the new addresses.

7.2 Non-Convertible Functions

Addresses and instructions that cannot be converted automatically are only
included as comments in the generated S7 program. These you must revise
yourself.

Asthe user, there are two ways in which you can convert these instructions:

* You can define your own S7 STL instruction sequence (macros) for these
instructions (if they occur in the user program). These can then be used
during conversion.

* You can edit the instruction sequences in the resulting S7 program.

Which method is better depends on the number of occurrences of such
instructions in your user program.

You can read about non-convertible addresses and instructions in Sections 3.11
and 3.12. These sections also contain suggestions for creating non-convertible
functionsin S7.
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7.3 Indirect Addressing — Conversion

Timers and
Counters

Blocks

Addresses

Indirect
Addressing via the
BR Register

Other Types of
Indirect
Addressing

The S5/S7 Converter uses STEP 7 instructions to convert indirect addressing
with DO FW and DO DW. The instruction sequence generated is generally
very extensive since the STEP 5 pointer hasto be converted into STEP 7
format, and the accumulator contents and the status word must be buffered
when doing so.

If your program contains very frequent indirect addressing, then it isworth
adapting to the indirect addressing in STEP 7. A substantial amount of
memory space can be saved by using appropriate programming techniques.

The list below explains how the S5/S7 Converter converts indirect addressing
in different cases:

Indirect addressing of timers and countersis converted into memory-indirect
addressing by using atemporary local data word.

Indirect addressing of blocks is converted into memory-indirect addressing by
using atemporary local dataword.

The new block numbers cannot be taken into account during conversion and
must therefore be corrected.

Theindirect addressing of addresses is converted by bits and words into
register-indirect addressing by using the address register AR1 and temporary
local data as a buffer for the status word STW, ACCU 1, and ACCU 2.

Theinstructions are not converted. Indirect addressing must be reprogrammed
inS7.

The instructions must be reprogrammed in S7.

For further information on indirect addressing, see Section 3.13.4.
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7.4  Working with Direct Memory Access

In STEP 5, access to absolute memory addresses was used for some functions.
Thistype of access no longer existsin STEP 7.

STEPS STEP7

Addressing data addresses in “extralong” data Addressing data addresses greater than 255 can

blocks now be done with standard instructions (L, T, ...).
Indirect addressing with the BR register Indirect addressing can be done with

register-indirect addressing (see Section 3.13.4
and the Statement List Programming Manual
1232/).

Using block transfers

For block transfers thereis now a system function
SFC20 BLKMOV. The memory areasto be
copied are specified at the block parameters. If the
memory areas are variable, then they can be
specified at the parameters“ANY pointer”, which
can be accessed in the user program.

7.5 Assigning Parameters

S5 Command
B<Block
Parameters>

Actual Parameters

Depending on the type of block transferred, the statement B <Formal
Parameters of Type“B”> runsin S5 as the following:

e “JU Logic Block” or as
* “A DB DataBlock”.

In this case, automatic conversion is not possible because of missing type
information in the formal parameter. Check your program for X instructions
with parameters of type “B” and then convert these instructions manualy.

For function blocks with parameters assigned, the S5/S7 Converter applies the
actual parametersto block calls without changing them. If you have already
defined addresses with an actual parameter, you will have to check this address
definition and change it if necessary.

Examples:
* Defining adata word number:
This must be converted into addressing done in bytes
* Defining an I/O address:
The new module address must be used.
e Transferring ablock:

The block must include the new block number.
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7.6 Standard Functions

S5 Standard
Function Blocks

Inserting FCs

If your S5 program contains standard function blocks (SFBs), they are
indicated as follows:

* Before conversion: by an asterisk in the “Std.” column of the dialog box
“Converting S5 Files[<Name>ST.S5D]”, and

* After conversion: by displaying the message “ Output not alowed (product
no.)”.

The STEP 7 Standard software is supplied with S7 functions that have already
been converted (former S5 standard function blocks) for floating-point math,
signal functions, integrated functions, basic logic functions, and math functions
with the names FC61 to FC125 (see Section 3.9).

To integrate the S7 functionsinto your S7 program, proceed as follows:
1. Open the project into which you want to insert the functions.

2. Open the standard library in the SIMATIC Manager with the converted S5
functions (StdLib30).

3. Copy therequired S7 functions from the standard library into the S7
program.
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Checking Data
Consistency

Compiling the
Source File

Before you can run the converted and edited program, it must be compiled
with the STL compiler. The procedure is exactly the same as for compiling a
newly written text file.

Select the the menu command File» Consistency Check to check the syntax
and consistency of the source file at any time without causing blocks to be
generated. Among other things, this function checks the following:

e Thesyntax,
* Thesymbols, and
* For the presence of called blocksin the program

Once the check is complete, a compiler report is generated which contains the
name of the compiled file, the number of lines compiled, the number of errors
present, as well as any warnings that occurred.

Select the menu command File» Compile to convert your sourcefileinto a
block.

Once the compiling is complete, a compiler report is displayed containing any
errors that occurred. Thisreport is similar to the one displayed after afile has
been checked for consistency. If a source file contains several blocks, then only
the error-free ones are compiled and saved.
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Troubleshooting

BN LAD/STL/FBD - [Example_VA\S7 Program(1)\..\Local Datai] HE
File Edit Insert PLC  Debug View Options Window Help
=) e a al
D& S| <|8|%=@] Celsm| %2
FUNCTI ON MEASVALS: | NT
TI TLE = Cal cul ati ng nmeasured val ue
NAME: MEASURED VALUE C :
ompiler Report [ x|
VERSI ON : 01. 00
File Name: LocalDatal
VAR _| NPUT
I NPUT VALUE : REAL; No. of Lines: 43
UPPER LIMT : REAL ; o .
LOER LIMT : REAL : No. of Warnings: 0 No. of Errors: 10
VAR_TEMP
LocAL REAL; ek ]
END_VAR
Error in Line 2, Colum 150 Level 2: Symbol MEASVALS not in symbol table.
Error in Line 2, Colum 10, Level 2: Type conflict for MEASVALS.
Error in Line 8, Colum 1, Level 2: Error witing to comment bl ock.
Error in Line 22, Colum 16, Level 2: Variable INPUT VALUE does not match either
Error in Line 26, Colum 2, Level 2: Syntax error in L.
Error in Line 26, Column 14, Level 2: Variable UPPER LIMT does not match either
Error in Line 27, Columm 15, Level 2: Variable LONMER LIMT does not match either
Error in Line 29, Colum 9, Level 2: Variable LOCAL does not match either a decl
Error in Line 30, Colum 5, Level 2: Syntax error in ;.
Error in Line 33, Colum 1, Level 2: Variable RET_VAL does not natch either a decl
Conpi l er Result: 10 Errors, 0 Warnings

Figure 8-1

Consistency Check and Compiling Source Files

If there are errors and/or warnings present in your converted program after it
has been checked for consistency or compiled, they are listed under the source
filein a second window section, along with their cause. If you then select an
error message, the location of the corresponding error in the source file will be
displayed. This coupling of error message with error location enables quick
troubleshooting and error correction.

You can correct errors and make changes in overwrite mode. Press the INSERT
key to toggle between the insert and overwrite modes.
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Configuration

This chapter presents an application exampleillustrating four areas of
operation that are either new in S7 or are now performed differently thanin S5:

* Anaog value processing

* Locd data

* Evauation of startup information in the organization blocks
* Block transfer

In this example, amotor operating to the right (clockwise) and left
(counter-clockwise) is controlled by means of a digital I/0O module. The speed
isread by an analog input module and can be output by an anal og output
module. The digital and analog modules used in this example must be able to
trigger a diagnostic interrupt.

PS CPU DI DO Al AO
[ EH
B H
%

Motor

Speed control

Speed measurement

Figure 9-1 Configuration of the Application Example
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9.1

Conversion of
Analog Values

Analog Value

Representation in

Analog Value Processing

The analog values are only processed in digital form by the CPU.
Analog input modules convert the analog processing signal into digital form.

Analog output modules convert the digital output value into an analog signal.

S5
Table 9-1 Example of the Analog Input Module 6ES5 460-7LA13
Resolution Analog Value
Bit Number 5 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Bit Value ps 21 210 29 28 27 26 25 24 23 22 21 20 A E (0]

Analog Value
Representation in
S7

The values for analog output modules are depicted as 12-bit twos complement.

Analog input modules can evaluate the value as a signed 12-bit number or asa
13-bit twos complement, as required.

The“O” bit indicates the amount of overflow.

The“E” hit isthe error bit, which is set when an error occurs (for example, a
wire break, if thius has been assigned parameters).

The “A” bit correspondsto the activity bit. If the bit is*0”, then the value
displayed isvalid.

For the same nominal range, the digitalized analog value is the same for input
and output values.

Analog values are represented as a twos complement.

Table 9-2 Example of Analog Input Modulesin S7
Resolution Analog Value
Bit Number 5 14 3 122 11 10 9 8,7 6 5 4 3 2 1 O
Bit Value s 214 213 12 211 210 29 28 27 26 25 24 23 22 21 20
The sign preceding (S = sign) the analog value is always in bit 15; here, a“0”
stands for apositive and a“1” for a negative value.
In S7 there are no error bits.
If an error occurs, the value W#16#7FFF is output.
In the case of an error, blocks having diagnostic capability can trigger a
diagnostic interrupt. The parameters for thisinterrupt are set in HWConfig.
From S5 to S7, Converter Manual
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Example

If the resolution of an analog module is less than 15 bits, the analog value is
left-aligned in the user data. Unoccupied low values have the signal state “0”.

In this example, the speed of the motor isread by an analog input module
having aresolution of 14 bits. This measured value has a bipolar range, such as
+/-10V.

Upper and lower limits are transferred as parameters.

The analog value is checked for an upper and lower limit. If the value read lies
outside of the permissible range, an error is reported using the binary result
(BR =0) and output asthe value “0”. If the value is acceptable, it is output.

The analog value is output viathe return value RET_VAL of the function. This
RET_VAL isafunctiona vaue. In S7, thisis a new functionality compared to
S5.
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FUNCTI ON FC1: REAL
TI TLE = Anal og Val ue Processing
NAME: ANALCOG
VERSI ON: 01. 00
VAR_| NPUT
| NPUT VALUE I NT; /1 | nput val ue
UPPER LIM T REAL ; /1 Upper limt for the anal og val ue
LOWVER LIMT REAL ; /1 Lower limt for the anal og val ue
END_VAR
BEG N
NETWORK
TI TLE = Checki ng Upper and Lower Limts
a;
L I NPUT VALUE; // Input value > Upper limt
L +27648;
>|;
)
a; /1l or
L I NPUT VALUE; // Input value < Lower limt
L - 27648;
<l;
)
NOT;
L 0;
JNB END; /1 |f upper or lower limt exceeded, no further
/1 processing, return value = 0 and BR = “0”
/1 1f no upper or lower lint exceeded => BR = “1”
NETWORK
TITLE = Converting Digital Value into Revol utions
L UPPER LIMT; // Formula for converting | NPUT VALUE into
/1 revol utions:
L LOMER LIMT; [// Analog value = (UPPER LIMT - LOMNER LIMT)
Il * | NPUT VALUE
-R /1 / (55296 (nunber of units))
L | NPUT VALUE;
| TD; /1 Convert value into floating-point nunber
DTR;
*R;
L 55296. 0;
IR
END: T RET_VAL,
BE;
END_FUNCTI ON
Figure 9-2 Analog Value Processing

9-4
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9.2 Temporary Local Data

Example 1

Temporary local datafunction as buffer storage and thus replace the scratchpad
flags used in S5. Temporary local data can be used in all logic blocks. These
data are lost after alogic block has been processed; they are located in the local
data stack (L stack).

Thisfirst example uses the temporary local data that are symboalically
addressed as a buffer. A preset speed is converted into the digitalized measured
value for the anal og output module having aresolution of 14 bits. This
measured value has a bipolar range, such as +/—10V.

Upper and lower limits are transferred as parameters.

The measured value is output viathe return value (RET_VAL) for the function.
Each function can optionally provide areturn value. The data type of the return
value isindicated in the description of the function. If no return valueis
provided, then the position for the data type has the entry VOID.

FUNCTI ON FC2: | NT
TI TLE = Cal cul ating

END_FUNCTI ON

NANME: MEASURED VALUE
VERS| ON\: 01. 00
VAR _| NPUT
| NPUT VALUE REAL ; /1 Input value (current val ue)
UPPER LIM T REAL; /1 Upper linit
LOER LIMT REAL; /] Lower limt
END_VAR
VAR_TEMP
LOCAL REAL ; /1 Local data as internediate result
END_VAR
BEG N
NETWORK
TITLE = Cal cul ati ng Measured Val ue
L I NPUT VALUE; /1 Formula for calculating units:
L 55296. 0; /1 Measured val ue = | NPUT VALUE
*R; /1 * 55296 (nunber of wunits)
/1 / (UPPER LIMT - LOAER LIMT)
T LOCAL,; /1 Intermediate result in |ocal data
L UPPER LIM T, /1 Buffer
L LOAER LIMT,;
- R7
L LOCAL;
TAK;
IR
RND; /1 Convert floating-point nunber into integer
T RET_VAL;

Measur ed Val ue

Figure 9-3 Calculating M
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Example 2 The second example uses local data which are addressed absolutely, such as
the S5 scratchpad flags, and shows how the clockwise and counter-clockwise
operation of amotor is controlled. In this example, the input byte and the
output byte are copied into the local data area. The user must reserve an areain
the local stack for temporary local data use since the L stack is being used by
the LAD/STL/FBD editor. The absolute addresses of the local data can be read
in the block located in the declaration section. The local data bits are linked to
each other by logic operationsin the program. This produces the output signals
which are written back at the end of the block to the output byte from the local
data. The addresses for the input and output bytes can be assigned parameters.
Note
Inserting new variablesin front of existing local datawill cause the
subsequent local data addresses to be shifted.

Table 9-3 Assignment of Inputs, Outputs, and Local Data

Address Local Data Name Description
I n.0 L 0.0 ON ON switch
Inl L0l STOP Stop motor
I n2 L0.2 EMERGENCY_STOP Emergency stop button
In3 L 0.3 MOTOR_RIGHT Motor: clockwise on
I n4 L04 MOTOR_LEFT Motor: counter-clockwise on
In5 L 05 LIMIT SWITCH RIGHT Limit switch, right
I n.6 L 0.6 LIMIT SWITCH LEFT Limit switch, left
I n.7 L 0.7 - Free
Qm.0 L 10 READY Motor is ready
Qm.l L11 CLOCKWISE Clockwise active
Qm.z2 L12 COUNTER-CLOCKWISE Counter-clockwise active
Qm3 L13 POSITION REACHED Position reached
Operation The voltage is applied via the ON switch. The motor is now ready for use; this

status is signaled by the output READY. The motor can be operated in a
clockwise or counter-clockwise direction as required by using the buttons
MOTOR_RIGHT and MOTOR_LEFT, respectively. The motor can only be
operated in one direction at atime. Before changing the direction of motor
rotation, the motor must be paused with the STOP switch. If atravel limit
switch is reached, the motor is stopped. The EMERGENCY _STOP button also
stops the motor; if this occurs then the motor can be restarted only after the

EMERGENCY _STOP button has been reset.
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FUNCTI ON FC3: VO D

TI TLE = Mdtor Control

NAME: MOTOR

VERSI ON\: 01. 00

VAR _| NPUT
I NPUT BYTE BYTE; /1 1nput byte

END_VAR

VAR I N_OUT
QUTPUT BYTE BYTE; /1 Qutput byte

END_VAR

VAR _TEMP
| MAGE_| NPUT BYTE BYTE; // 1 mage of input byte
| MAGE_QUTPUT BYTE BYTE; // 1 mage of output byte

END_VAR

BEG N

NETWORK

TITLE = Mdtor Control
L | NPUT BYTE; /1 Copy input byte into |local data area
T | MAGE_| NPUT BYTE;
L QUTPUT BYTE; /1 Copy output byte into |local data area
T | MAGE_OUTPUT BYTE;
ON LO. O; /1 Motor not switched on (no voltage)
ON LO. 2; /1 or EMERGENCY_STOP button pushed
R L1.0; /1l => Motor is ready to reset
R L1. 1; /1 => Reset notor control
R L1. 2;
R L1. 3; /1 => Reset position reached
JC END; /1 => No further signal evaluation
A LO. O; /1 Nbtor switched on
S L1. O; // => Set nmotor switched on
A LO. 3; /1l Operate nmotor clockw se
AN LO. 4; /1 Disable: no operation counter-clockw se
AN L1. 2; /1 and counter-cl ockwi se not active
FP M. 0; /1l Create positive edge
S L1.1; /1 Then: switch on cl ockw se
R L1. 3; /1 Reset position reached
A LO. 4; /1 Operate motor counter-clockw se
AN LO. 3; /1 Disable: no operation clockw se
AN L1. 1, // and cl ockwi se not active
FP M. 1; /] Create positive edge
S L1. 2; /1 Then: switch on counter-clockw se
R L1. 3; /] Reset position reached
a;
A LO. 5; /'l Right limt switch reached and
A L1.1; /1 cl ockw se active
)
q; /1l or
A LO. 6; // Left limt switch reached and
A L1. 2; /1l counter-clockw se active
)
S L1. 3; // => Position set reached
(0] LO. 1; /1 Stop nmotor switch pushed or
(6] L1. 3; /1 position reached
R L1.1; /1l => Reset notor operation
R L1. 2;

END: L | MAGE_QUTPUT BYTE; /1 Copy local data to output byte
T QUTPUT BYTE;

END_FUNCTI ON

Figure 9-4 Motor Control Function
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9.3 Evaluating the Startup Information from the Diagnostic Interrupt OB

(OB82)

Startup
Information

Start Information
for OB82

Example

If the organization blocks are called by the operating system, the user is
provided with system-wide startup information in the local data stack. This
startup information is 20 bytes long and is available after OB processing has
started.

The startup information from the diagnostic interrupt OB contains the logical
base address with four bytes of diagnostic information. The exact structure of
this startup information is described in the Reference Manual [235/. Templates
for the corresponding variable declaration table are located in the “ StdLib30”
standard library under the heading “ StdOBs".

Based on diagnostic interrupt parameters previously configured in HWConfig,
the digital modules make a request to the CPU for adiagnostic interrupt. This
function applies to both incoming and outgoing events. After this request, the
operating system calls the organization block OB82.

You can disable, delay, or re-enable the calling of the diagnostic interrupt OB
with the help of the system functions (SFCs) 39 to 42. For further information,
see the Reference Manual /235/.

The following sample program shows how the external auxiliary voltage is
evaluated. If the external auxiliary voltageis interrupted, the bit
NO_EXT_VOLTAGE issetin DB82 “DB_DIAG". In addition, the module
address and the time of the event are also saved. Thisinformation can be
processed later in the program.

Before the STL source fileis compiled, the symbol for the data block DB82
“DB_DIAG” must be entered in the symbol table.
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DATA_BLOCK DB_DI AG
TITLE = Di agnostic Data

NANE: DB DI AG
VERSI ON\: 01. 00
STRUCT
MDL_ADDR I NT; // Mbdul e address
NO_EXT_VOLTAGE BOOL; /1 No error bit for ext. aux. voltage
DATE_TI ME DATE_AND_TI ME; // Date and time at which the
/1 diagnostic interrupt was triggered
SFC_RET_VAL I NT; /1 Return code of SFC BLKMOV
END_STRUCT;
BEG N
END_DATA_BLOCK
ORGANI ZATI ON_BLOCK 0B82
TITLE = Di agnostic Interrupt
NAME: Di agnhostic
VERSI ON: 01.00
VAR_TEMP
0B82_EV_CLASS BYTE; // Event class and |Ds:
/] B#16#38: outgoi ng event
/1 B#16#39: incom ng event
OB82_FLT_ID BYTE; // Error code (B#16#42)
B82_PRIORITY BYTE;// Priority class 26 or 28
0B82_(OB_NUMBR BYTE; // OB nunber
OB82_RESERVED 1 BYTE; // Reserved
0B82_I| O_FLAG BYTE; // | nput nodul e: B#16#54
/] CQutput nodul e: B#16#55
0OB82_MDL_ADDR INT; // Logical base address of nodul e
/1 where the fault occurred
OB82_MDL_DEFECT BOOL;// Modul e is defective
OB82_| NT_FAULT BOOL;// Internal fault
OB82_EXT_FAULT BOOL; // External fault
OB82_PNT_I| NFO BOOL; // Channel fault
OB82_EXT_VOLTACE BOOL;// External voltage failed
OB82_FLD_CONNCTR BOOL; // Front panel connector not plugged
OB82_NO_CONFI G BOCOL;// Module is not configured
OB82_CONFI G_ERR BOCOL;// Incorrect paraneters on nodul e
OB82_MDL_TYPE BYTE;// Bit 0 to 3: Mdule class
// Bit 4: Channel information exists
/1 Bit 5: User information exists
/1 Bit 6: Diag. interrupt fromsubstitute
/1 Bit 7: Reserve
0B82_SUB_MDL_ERR BOCL; // Subnodule is missing or has an error
0B82_COVM FAULT . BOOL; // Conmunication problem
OB82_MDL_STOP : BOOL; /] Operating node (0: RUN, 1: STOP)
OB82_WICH DOG FLT . BOOL;// Watchdog tiner responded
OB82_I NT_PS_FLT BOCL;// Internal power supply failed
0B82_PRI M BATT_FLT BOOL;// Battery dead
0OB82_BCKUP_BATT_FLT BOOL;// Entire backup failed
OB82_RESERVED 2 BOOL; // Reserved
OB82_RACK_FLT BOOL; // Rack failure
OB82_PROC _FLT BOOL; // Processor failure
OB82_EPROM FLT : BOOL;// EPROM fault
OB82_RAM FLT : BOOL;// RAM fault continued
Figure 9-5 Diagnostic Data Evaluation
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OB82_ADC FLT BOOL;
OB82_FUSE_FLT BOOL;
OB82_HW I NTR FLT © BOOL;
OB82_RESERVED_3 : BOOL;

OB82_DATE_TI ME: DATE_AND TI ME;
END_VAR

BEG N
NETWORK
TITLE = Diagnostic Interrupt

L 0OB82_MDL_ADDR;
T DB_DI AG MDL_ADDR,
L OB82_EV_CLASS;
L B#16#38;
==| ;
JC €§;
A 0B82_EXT_VOLTACE;
S DB_DI AG. NO_EXT_VOLTAGE;
JU TI ME;
€o; A OB82_EXT_VOLTAGE;
agai n
R DB_DI AG NO_EXT_VOLTAGE;
NETWORK
TI TLE = Save Tinme
TIME: CALL SFC20(

SRCBLK : =0B82_DATE_TI ME,

RET_VAL: =DB_DI AG. SFC_RET VAL,

DSTBLK : =DB_DI AG DATE_TI ME) ;
END_ORGANI ZATI ON_BLOCK

Il

Il

11

Il

I

11
Il

Il

ADC/ DAC error

Fuse bl own

Har dware interrupt | ost

Reser ved

Date and time when OB was call ed

Save nodul e address

Event class = B#16#38:
Qut goi ng event

I ncom ng event:
Check if no ext.
Set bit

auxiliary voltage

Qut goi ng event:
Ext. auxiliary voltage present

Reset bit

SFC BLKMOV

Save date and tinme at which
di agnostic interrupt

was requested

Figure 9-6 Diagnostic Data Evaluation, continued

9-10

From S5 to S7, Converter Manual
A5E00261402-01



Application Example

9.4 Block Transfer

You can use the system function SFC20 “BLKMOV"” (block move) to copy the
contents of one memory area, the “source field”, into another memory area, the
“target field”.

You can use SFC20 “BLKMOV” to copy al inputs, outputs, bit memory, and
data.

Parameters
Parameter | Declaration | Data Type Memory Description
Area

SRCBLK INPUT ANY I,Q,M, D, L | Indicatesthe memory areato be copied
(source field).

RET_VAL OUTPUT INT I,Q,M, D, L | If anerror occurs during processing of
the function, the return value will
contain an error code.

DSTBLK OUTPUT ANY I,Q, M, D, L | Indicatesthe memory areainto which
the datais to be copied (target field)

Note

The source and target fields must not overlap. If the target field specified is
larger than the source field, than only the amount of data contained in the
source field is copied into the target field.

If the target field specified is smaller that the source field, then only the
amount of data that the target field can accept is copied.

If you want to have the parameters for the source and target areas of SFC20
“BLKMOV” filled with variable values instead of constant pointers, you can
do this by using temporary variables of the data type ANY.
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Structure of the
ANY Pointer for
Data Types

Table 9-4 ANY Pointer

The following tables show the structure of the ANY pointer.

Byten Byte Byte Byte Byte Byte Byte Byte Byte Byte
n+1 n+2 n+3 n+4 n+5 n+6 n+7 n+8 n+9
B#16#10 | Type Length Data block no. for Area pointer
(see data blocks . _
Table (see Figure 9-7)
9-5)
Table 9-5 Type (Byte n+1)
Value: 01 02 03 04 05 06 07
Type: BOOL BYTE CHAR WORD INT DWORD |DINT
Value: 08 09 OA 0B oC OE 13
Type: REAL DATE TOD TIME S5TIME DT String
Byte n+6 Byte n+7 Byte n+8 Byte n+9
31.. .24 23.. .16 15.. .8 7. 0

[a 000 Orrr [0000 O bbb| bbbb bbbb|[bbbb b xxx|

Bits 2 to 0 (xxx): Bit address;
Number of addressed bit (area
0to7)

Bits 18 to 3 (bbbb bbbb bbbb bbbb): Byte address;
Number of addressed byte (area 0 to 65 535)

Bits 26 to 24:
Area ID for

rrr:
000=P
001=I
010=Q
011=M
100 = DBX
101=DIX
111=L

area-crossing addressing

Bit 31 = 0 (a) indicates area-internal addressing
Bit 31 = 1 (a) indicates area-crossing addressing

Figure 9-7 Area Pointer (Byte n+6 to Byte n+9)

9-12

From S5 to S7, Converter Manual
A5E00261402-01




Application Example

Example The example shows a function which uses the the system function SFC20
“BLKMOV” to copy data area (in data blocks). Variable source and target
areas can be entered as parameters.

Principle The function contains two ANY pointersin the local data areaand one ANY
pointer for the target area. Asarule, the ANY data type can only be used for
variablesin the local data area.

In the function, the ANY pointer is assigned avalue asindicated in the
structure previously described. This value isindicated in the parameters when
the SFC20 “BLKMOV” iscalled.

FUNCTI ON FC4: | NT

TI TLE = Copying Data Areas
NAME: COoPY

VERSI ON: 01. 00

VAR _| NPUT
SOURCE_DBNO I NT
SOURCE_BEG N I NT
SOURCE_LENGTH : I NT
DEST_DBNO : | NT;
DEST_BEGQ N I NT
DEST_LENGTH I NT

END_VAR

VAR TEMP
POl NTER_SOURCE: ANY;
PO NTER DEST : ANY;
END_VAR

BEG N
NETWORK
TI TLE = Preparing Source Pointer

L P##POl NTER_SOURCE;
LARL;

L WE16#1002;

T LW ARL, P#0.0];
L SOURCE_DBNO,

T LW ARL, P#4.0];
L SOURCE_BEG N;
SLD  3;

o DW#16#84000000;
T LD ARL, P#6.0];
L SOURCE_LENGTH;
T LW ARL, P#2.0];

11

11
11

DB no. of source area

Data word no. of begi nning of source area
Length of source area in bytes

DB no. of destination area

Data word no. of beginning of dest. area
Length of destination area in bytes

ANY pointer for the source area
ANY pointer for the destination area

Load address of pointer in source area
into address register 1

Wite area ID for data area in

ANY pointer for source

Wite DB no. in ANY pointer for source

Convert beginning of data area
into pointer fornmat,
Link area ID
and wite in ANY pointer for source
Wite length of data area in ANY pointer
for source

continued

Figure 9-8 Copying Data Areas
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NETWORK
TI TLE = Preparing Destination Pointer

L P##PQO NTER_DEST,; /1
LARL; /1
L WE16#1002; /1
T LW AR1, P#0.0]; 11
L DEST_DBNO, /1
T LW ARL, P#4.0];
L DEST_BEG N, /1
SLD 3; /1
oD DWt16#84000000; /1
T LD[ AR1, P#6.0]; /1
L DEST_LENGTH, /1
T LW AR1, P#2.0]; /1

NETWORK

TI TLE = Copyi ng Data
CALL SFC 20( /1
SRCBLK : = PO NTER_SOURCE, 11
RET_VAL: = RET_VAL, /1
DSTBLK : = PO NTER _DEST) ; /1

END_FUNCTI ON

Load address of pointer to dest.
in address register 1

Wite area ID for data area in
ANY pointer for destination

DB no. in ANY pointer for destination

area

Convert begi nning of data area
into pointer fornat
Link area ID

and wite in ANY pointer for destination
Wite length of data area to ANY pointer

for destination

Copy data with SFC BLKMOV (bl ock transfer)

Pointer to source area
Return code of SFC BLKMOV
Pointer to destination area

Figure 9-9 Copying Data Areas, continued

9.5 Calling the Examples

This section contains the symbol table, the data blocks required for assigning
values to the block parameters, and the organization block OB1 with the calls

for the functions previously described.

Table 9-6 Symbol Table
Symbol Address Data Type | Comments
DB_DIAG DB82 DB82 Diagnostic data block
DB_MEASVALS DB100 DB100 Data block for measured values
DB _MOTOR 1 DB110 DB110 Data block for motor 1
ERROR MW 100 WORD Return value of the function FC4 for block
transfer

9-14
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DATA BLOCK DB_MEASVALS

TI TLE = Measured Val ues

NANE: DB _MEASVALS
VERSI ON\: 01. 00
STRUCT
ANALOGVAL 1 REAL ; /1 Anal og value 1 from FCl
ANALOGVAL _2 REAL; // Anal og value 2 from FC2
DI G TALVAL_2 I NT; /1 Digitalized nmeasured value from FC2
END_STRUCT;
BEG N

END_DATA BLOCK

DATA BLOCK DB_MOTOR 1

TITLE = Motor Data
NAME: DB_MOTOR 1
VERSI ON: 01. 00
STRUCT
CONTROL WORD : WORD; /1 Control of notor 1
SPEED : REAL; /1 Speed of notor 1
TEMPERATURE REAL ; /1 Tenperature of notor 1
CURRENT REAL ; /1 Current consunption of motor 1
END_STRUCT;
BEG N

END_DATA_BLOCK

ORGANI ZATI ON_BLOCK OB1

TITLE = Call in Cycle

NANME: CYCLE

VERSI ON: 01. 00

VAR _TEMP

STARTI NFO ARRAY [1..20] of BYTE;

END_VAR

BEG N

NETWORK

TITLE = Call of Functions

CALL FC1(
| NPUT VALUE
UPPER LIMT
LOWVER LIMT
RET_VAL

CALL  FC(
| NPUT VALUE
UPPER LIM T
LONER LIMT
RET_VAL

CALL  FC3(
I NPUT BYTE
QUTPUT BYTE

CALL FCA(
SOURCE_DBNO
SOURCE_BEGQ N
SOURCE_LENGTH :
DEST_DBNO
DEST_BEG N
DEST_LENGTH
RET_VAL

END_ORGANI ZATI ON_BLOCK

// Call function for
I WO, /1 anal og val ue processing
+10. 0, /1 Measured range: +/ -10V
-10. 0,

DB_MEASVALS. ANALOGVAL_1);
/1 RET_VAL = Anal og val ue
/1 Call function for calculating
/1 digitalized nmeasured val ue
DB_MEASVALS. ANALOGVAL_2, //

+10. 0, /1 Measured range: +/-10V
-10.0,
DB_MEASVALS. DI G TALVAL_2);
// RET_VAL = digitalized neas. val ue
/1 Call function for notor control
I B 4,
B 8);
/1 Call function for block transfer
100, /! Source: DB100
0, /1 Fromdata byte DBB 0
8, /1 Length: 4 Byte
110, /1 Destination: DB110
2, /1 Fromdata byte DBB 6
8, /1 Length: 4 bytes
ERROR) ; /1 RET_VAL = Error code for SFC20 BLKMV

Figure9-10 OB1

From S5 to S7, Converter Manual
A5E00261402-01

9-15



From S5 to S7, Converter Manual
A5E00261402-01



Appendix

Address and Instruction Lists

Literature List

Glossary, Index



From S5 to S7, Converter Manual
A5E00261402-01



Address and Instruction Lists

A.1 Addresses

Convertible
Addresses

Table A-1

The following addresses are converted:

Convertible Addresses

S5STL
(German)

S5STL
(International)

S7STL
(German)

S7STL
(International)

A

ToF

A

TR

" AB"

" OB

"AB”

OB

"AD”

"QD”

"AD"

"QD”

» AW”

QW

" AW”

QW

"BE’

"BN"

nn

"

"D”

"DBX"

"DBX”

" DW”

"DW”

"DBW”

"DBW”

"DD”

"DD”

"DBD”

"DBD”

"DR"

"DR”

"DBB”

"DBB”

"DL”
=
"EB
"ED”

—~
o
nE
D

"DBB”
=
"ER"
"ED”

"DBB”
"
"B
"ID”

"EW”

"W

"EW”

"W

"M

=

"M

"M

"MB”

=

"MB”

"MB"

"MD"

"ED”

"MD"

"MD"

"MW

MW"

"MW?

"PW”

" PEW/PAW”

" PIW/PQW”

"py”

"py”

" PEB/PAB”

" PIB/PQB”

QB

"OY”

"PEB/PAB”

" PIB/PQB”

QW

"OW"

" PEW/PAW"

" PIW/PQW”

ng

ng

"M

"M

"gp”

"D

"MD"

"MD"

QW

" QW

MW"

"MW”
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Address and Instruction Lists

Table A-1 Convertible Addresses

S5STL S5STL S7 STL S7STL
(German) (International) (German) (International)
"SY” "SY” "MB” "MB”
" "T" T T
"z’ e "z’ "c
"= <Formal "= <Formal "# <Formal "# <Formal
parameter>" parameter>" parameter>" parameter>"

Non-Convertible

Table A-2 shows the addresses that cannot be converted.

Addresses
Table A-2 Non-Convertible Addresses
S5 STL (German) S5 STL (International)

"Al" Al

A2 "A2

"BA” "RI”

"BB” "RY

"BR” "BR”

"BS’ "RS’

"BT” "RT”

"CB” "CY”

"CD” "CD”

"CW” "CW”

"GB” "GY”

"GD” "GD”

"GW” "GW”
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Address and Instruction Lists

A.2 Instructions

Conversion
Instructions
without Addresses

Table A-3 shows all the S5 instructions (without addresses) in STL that can be
converted automatically into S7 STL:

Table A-3 Convertible Instructions (without Addresses)
S5STL S5STL S7STL S7STL
(German) (International) (German) (International)
"AF’ "RA” "CALL SFC42’ "CALL SFC42"
"AS "1A” "CALL SFC41” "CALL SFC41”
"BEA” "BEU” "BEA” "BEU”
"BEB” "BEC” "BEB” "BEC”
"+D” "+D” "+D” "+D”
"_D" "_D" "_D" "D"
"1=D" "1=D" "==D" "==D"
"><D” "><D” "<>D” "<>D”
»>D” ">D” ">D” ">D”
">=D" ">=D" ">=D" ">=D"
"<D” "<D” "<D” "<D”
"<=D" "<=D" "<=D" "<=D"
"DED” "DED” "BTD” "BTD”
"DEF’ "DEF’ "BTI” "BTI”
"DUD” "DUD” "DTB” "DTB”
"DUF’ "DUF’ "ITB” "1TB”
"ENT” "ENT” "ENT” "ENT”
"4 "HE "4 "4
g " " "
"F "F i i
"XF" "XF" T T
"I=p "I=F "== ==
" ><F’ " ><F’ T<>| <>
">E ">E "1 ">
">=p ">=p ">=|” ">=|”
S S "<]” "<|”
"<=p "<=p r<=|” n<=|”
"FDG” "FDG” "DTR” "DTR"
"+G" "+G" "+R" "+R"
"—G" "—G" "R” "R”
"G "G "IR” "IR”
"xG” "xG” "*R” "*R”
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Table A-3 Convertible Instructions (without Addresses), continued
S5STL S5STL S7STL S7STL
(German) (International) (German) (International)
"I=G" =G "==R" "==R"
"><G" "><G” "<>R” "<>R"
">G” ">G >R’ "SR’
">=G" ">=G ">=R’ ">=R’
<G B CH "<R" "<R"
"<=G" "<=G" "<=R’ "<=R"
"GFD” "GFD” "RND” "RND”
"KEW” "CFW” "INVI” "INVI”
"KZD” "CSD” "NEGD” "NEGD”
"KZW” "CSW” "NEGI” "NEGI”
"o” el e "o”
"o’ "o’ "o’ "o
"ow” "ow” "OW” "OW”
"STP” "STP’ "CALL SFC 46" "CALL SFC 46"
"STS "STS "CALL SFC 46" "CALL SFC 46"
"STW” "STW” "CALL SFC 46" "CALL SFC 46"
"TAK” "TAK” "TAK” "TAK”
"ue "AC "ue "AC
"Uw” " AW "UW” "AW”
"XOow” "XOwW” "XOow” "XOw”
") ") ") ")
TR KK kK "NETWORK” "NETWORK”

Conversion Table A-4 shows all the S5 instructions (with addresses) in STL that can be
Instructions with converted automatically into S7 STL:
Addresses

Table A-4 Convertible Instructions (with Addresses)

S5STL S5STL S7STL S7STL
(German) (International) (German) (International)

"A” "C "AUF’ "OPN”

"ADD BF" "ADD BF "y "y

" ADD DH" " ADD DH" "y "y

"ADD KF” "ADD KF” "+ "+

"AX” "CX” "AUF’ "OPN”

"B” "DO” " Instruction "Instruction
sequence for sequence for
indirect indirect
addressing” addressing”
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Table A-4

Convertible Instructions (with Addresses), continued

S5STL
(German)

S5STL
(International)

S7STL
(German)

S7STL
(International)

"BA"

"BA”

"BAB"
"o»

"DOC”
"

»SpR”
"DEC”

" 3o
"DEC”

=

"G

"CALL SFC22”

"CALL SFC22”

nEX”

"GX”

"CALL SFC22’

"CALL SFC22"

"FR”

"FR”

"FR”

"FR”

"INC”

"INC”

"

n»

n»

n

"L

"LD"

Lo

Lo

"NOP”
"o

"NOP”
"o

"NOP”
"o

"NOP”
"o

" ON"

" ON"

" ON”

" ON”

npr

"TB”

"SET;
u”

"SET,
A

" PN

"TBN"

"SET;
UN”

"SET,
AN”

"R

"R

"R

"R

"RB"
"RD"

"RB"
"RD”

"R
"R

"R
"Ry

"RLD”

"RLD”

"RLD”

"RLD”

"RLW”
"RRD"

"RLW”
"RRD”

"RLW”
"RRD”

"RLW”
"RRD”

"RRW”

"RRW”

"RRW”

"RRW”

"RU”

"RU”

"SET;
R

"SET,;
R’

ngy

ngy

ngy

ng

ngEr

"GAR”

"SED”

"SA” Timer
"ZR" Zahler

" SF” Timer
"CD” Counter

o=

"gp”

=

"gny”

ngp

"g D

"g D

"g D"

"gL D"

"QLW?

"W

"W

"W

" SpR”

" JU”
"iC

" SpR”

" JU”
" 3o

" SPM”

"M

" SPM”

"M

" SPN”
»gpO”

" IN”
" 30"

" SPN”
" gpQ”

" JICN”
" 30"

" Spp”

"3

»Spp

"3
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Non-Convertible
Instructions

Table A-4 Convertible Instructions (with Addresses), continued

S5STL S5STL S7STL S7STL
(German) (International) (German) (International)

"SPR” "JUR" "SPA” "Ju”

"SpPz” "Jz" "SpPz” "Jz"

"SRD” "SRD” "SRD” "SRD”

SSA " SsU” "Ss Timer "Ss Timer
"zZV"  Zéhler "CU”  Counter

"SyU” "SyU” "SET; "SET;
S S

"SvVw " SSW” "SSl” S

"svz” "SEC” TSV Timer "SE” Timer
"S Zahler "S’ Counter

"T” "T” "T” "T”

"TNB” "TNB” "CALL SFC20” "CALL SFC20”

"TNW” "TNW” "CALL SFC20” "CALL SFC20”

"y” "A” "y "A”

"UN” "AN” "UN” "AN”

"ZR’ "CD” "ZR" "CD”

"ZV” "cu” "ZV" "CU”

The following table shows the S5 STL instructions that cannot be converted

automatically.

Table A-5 Non-Convertible Instructions

S5 STL (German)

S5 STL (International)

"AAS’ "1Al"
"AAF "RALI”
"ABR" "ABR”
"ACR" "ACR"
"AFF’ "RAE’
"AFS’ "IAE”
"ASM” "ASM”
"BAF’ "BAF’
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Table A-5 Non-Convertible Instructions
S5 STL (German) S5 STL (International)
"BAS’ "BAS’
"BI” (can only be converted for "DI” (can only be converted for
parameter type D/constant) parameter type D/constant)
"BLD” "BLD”
"LB” "LB"
"LD” "LD"

"LD=<Formal parameter>" (can only be
converted for parameter type D/constant)

"LD=<Formal parameter>" (can only be
converted for parameter type D/constant)

"LDI”

»LDI”

"LIM” "LIM”
"LIR” "LIR”
"LRB” "LRB”
"LRD” "LRD”
"LRW” "LRW”
LW LW

"LW=<Formal parameter>" (can only be
converted for parameter type D/constant)

"LW=<Formal parameter>" (can only be
converted for parameter type D/constant)

"MA1"

"MA1"

"MAB” "MAB”
"MAS’ "MAS’
"MBA” "MBA”
"MBR” "MBR”
"MBS’ "MBS’
"MSA” "MSA”
"MSB” "MSB”
"SEF” " SEE”
"SES’ "SED”
"SIM” "SIM”
"TB” "TB”
"TDI” "TDI”
"TIR” "TIR”
"TSC” "TSC”
"TSG” "TSG”
"TRB” "TRB”
"TRD” "TRD”
"TRW” "TRW”
"TW” "TW”
"TXB” "TXB”
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Table A-5 Non-Convertible Instructions
S5 STL (German) S5 STL (International)
"TXW” "TXW”
"UBE" "UBE"
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Glossary

A

Actual Parameter Actual parameters replace formal parameters when a function block (FB) or
function (FC) is called, for example, the formal parameter “START” is
replaced by the actual parameter “13.6".

Address An address includes the address identifier and the physical memory location
where the address is stored. Examples: Input 112.1; Memory Word MW25;
Data Block DB3.
An addressis part of a STEP 7 statement and specifies what the processor
should execute the instruction on. Addresses can be absolute or symbolic.

Assigning Assigning parameters means setting the behavior of a module.

Parameters

B

Block Blocks are part of the user program and can be distinguished by their function,
their structure, or their purpose. STEP 7 provides the following types of
blocks:
* Logic blocks (FB, FC, OB, SFB, SFC)
» Datablocks (DB, SDB)
e User-defined datatypes (UDT)

Block Call A block call isthe branch into the called block taken during program
processing.

Block Parameter Block parameters are token values within multipurpose blocks which are

supplied with current values when the corresponding block is called.
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Glossary

C

Compiler

Configuring

D

Data Block (DB)

Data, Static

Data, Temporary

Data Type

Data Type,
Complex

Data Type,
Elementary

Declaration
Section

Glossary-2

The compiler program for compiling a program written in a higher
programming language to the machine code the CPU usesis known as a
compiler.

Configuring is the selection and putting together of the individual components
of aprogrammable logic controller (PLC), and the installation of the required
software and adapting it to the specific task (such as assigning parameters to
the modules.)

Data blocks are areas in the user program which contain user data. There are
shared data blocks which can be accessed by all logic blocks, and there are
instance data blocks which are associated with a particular function block (FB)
call. Data blocks contain no logic instructions, in contrast to al other types of
block.

Static data are local datain afunction block which are stored in the instance
data block and thus remain stored until the next function block call.

Temporary data are local datain ablock which are kept in the L stack while
the block isin use and are no longer available once the block is closed.

With the help of datatypes you can specify how the value of avariable or a
constant isto be used in the user program. There are two data types according
to IEC 1131-3 available to users of SIMATIC S7: elementary and complex
data types.

Complex data types are defined by the user with the data type declaration.
They do not have their own name and cannot be used more than once. A
distinction is made between arrays and structures. The data types Sring and
Date and Time also belong to this category.

Elementary data types are predefined data types according to IEC 1131-3, for
example, the data type BOOL defines abinary variable (“bit"); the data type
INT defines a 16-bit fixed-point variable (integer).

Thelocal data of alogic block are declared in the declaration section if the
program is generated using atext editor.
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Glossary

Formal Parameter

Function (FC)

Function Block
(FB)

1/0, Distributed
(DP)

Instance

Instance Data
Block

A formal parameter is atoken value for the “actual parameter” of logic blocks
which can be assigned parameters. The formal parameters are declared by the
user in the case of function blocks and functions, but are already present in the
case of system function blocks and system functions.

When calling the block, an actual parameter is assigned to the formal
parameter so that the called block works with its current value. The formal
parameters are included amongst the local data of the block and are divided
into input, output, and 1/O parameters.

According to the International Electrotechnical Commission’s |[EC 1131-3
standard, functions are logic blocks that do not reference an instance data
block, meaning they do not have a’ memory’. A function allows you to pass
parameters in the user program, which means they are suitable for
programming complex functions that are required frequently, for example,
calculations. Asthereis no memory available, the calculated values must be
processed immediately following the FC call.

According to the International Electrotechnical Commission’s |[EC 1131-3
standard, function blocks are logic blocks that reference an instance data block,
meaning they have static data. A function block allows you to pass parameters
in the user program, which means they are suitable for programming complex
functions that are required frequently, for example, control systems, operating
mode selection. As function blocks have a’memory’ in the form of the
associated instance data block, its parameters (outputs, for example) can be
accessed at any time and any point in the user program.

The distributed 1/O consists of analog and digital modules which are located at
aphysical distance from the central rack. Characteristic of the distributed 1/O
isthe modular rack system whose aim it is to save connecting wires, thereby
saving costs by placing the 1/0O modules close to the process.

An “instance” isthe call of afunction block; an instance data block is
associated with this call.

An instance data block stores the formal parameters and static data for function
blocks. Aninstance data block can be associated with a function block call or a
call hierarchy of function blocks.
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Instruction

Local Data

Logic Block

Macro

O

Online Help

Organization Block
(OB)

Glossary-4

Aninstruction is part of a STEP 7 statement and specifies what the processor
should do.

Local data are data assigned to alogic block which are declared in its
declaration section or its variable declaration. They cover (depending on the
block): formal parameters, static data, temporary data.

In SIMATIC S7, alogic block is ablock that contains part of the STEP 7 user
program. The other type of block is a data block which contains only data. The
following list shows the types of logic blocks:

* Organization block (OB)

¢ Function block (FB)

* Function (FC)

* System function block (SFB)
* System function (SFC)

A macro is a sequence of instructions which are combined into a mnemonic
call optimized for execution.

STEP 7 enables you to display context-sensitive help on the screen while you
are working with the programming software.

Organization blocks form the interface between the CPU operating system and
the user program. The sequence in which the user program should be
processed is laid down in the organization blocks.
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Pointer

Programming
Language

Project

R

Retentive

S

S7 Program

Shared Data

Statement

Statement List
(STL)

A pointer is avariable which does not possess a particular value but the
address of another variable. With pointer instructions, the type on the right side
of the operator must correspond to the type on the | eft side.

A programming language is used to create user programs and provides a
specific "vocabulary’ for this purpose in the form of text instructions or graphic
elements. These instructions are entered by the user using an editor and
compiled into an executable user program.

A project isacontainer for al objectsin an automation task, independent of
the number of stations, modules, and how they are connected in a network.

Data are called retentive if they have the same value after a power supply
failure as before the power supply failed. The data are backed up in two ways:

* Voltage backup

* Backup memory

An S7 program is a container for blocks, source files, and charts for S7
programmable modules which a so contains the symbol table.

Shared data are data which can be accessed from any logic block (function
(FC), function block (FB), organization block (OB)). These are bit memory
(M), inputs (1), outputs (Q), timers (T), counters (C), and elements of data
blocks (DB). You can access shared data either absolutely or symbolically.

A statement is the smallest independent part of a user program created in a
textual language. It represents acommand for the processor.

Statement List is atextua representation of the STEP 7 programming
language, similar to machine code.
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Glossary

Symbol

Symbol Table

\Y,

Variable

Glossary-6

A symbol is aname defined by the user, taking syntax rules into consideration.
This name can be used in programming and in operating and monitoring once
you have defined it (for example, as avariable, a datatype, ajump label, or a
block).

Example: Address: 15.0, Data Type: BOOL, Symbol: Emer_Off _Switch

A distinction is made between shared symbols and block-specific symbols.
Shared symbols are available to al parts of the program, therefore the symbol
you assign must be unique for the whole user program. Block-specific symbols
are only recognized within the block for which they were assigned.

A table used to assign symbols (or symbolic names) to addresses for shared
data and blocks.
Examples: Emer_Off (Symbol), 11.7 (Address)

Controller (Symboal), SFB24 (Block)

A variable defines an item of data with variable content which can be used in
the STEP 7 user program. A variable consists of an address and a data type,
and can be identified by means of a symbolic name.
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A

Absolute address, 4-3
Accumulator instructions, |3-35
Actuator-sensor interface, |2-10
Adapter casing, 2-13
Address
convertible, A-1
non-convertible, A-2
Address dlocation, 4-4
Address areas, overview, 3-32
Address changes, 7-2
Addressregister, 3-45
Addressing
absolute,|3-39
data addresses, 3-41
indirect, 3-43
converting, 7-4
memory-indirect, 3-44
register-indirect, 3-45
symboalic, 3-39
Analog functions, 3-29

Analog value processing, example, 9-2

ANY pointer, 9-12

ASii, 2-10

AS5H11, 2-3

ASCII sourcefile, 3-16
Assignment list, 3-39, 5-1, 5-4
Authorization, |3-2

B

Background processing, |3-20
Backup battery, |2-7
Basic functions, 3-29
Battery failure,|3-22
Bit logic instructions, 3-35
Bit memory, CPU, 2-6, 2-7
Block instructions, |3-37
Block transfer, 7-5

example, 9-11
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Block transfers, 3-37
Block types, in S5 and S7,3-25
Blocks
comparison STEP 5/STEP 7, 3-17
CPU, 2-6, 2-7
Blocks container, STEP 7 object, 3-6
BR register, 7-5

C

Cam control,|2-13
CD-ROM, 2-1
Command output instructions, 3-37
Comment block,|3-17
Communication, event-driven, 2-19
Communication functions, 2-18
Communications processors, 2-10
Comparison instructions, 3-36
Compiling,|8-1
Complete restart,|3-20
Configuration tool, 2-22
Configuring
communication connections, 3-11
hardware, 3-9
Connection, configured to S5 station, 3-12
Connection table, 3-11
STEP 7 object, 3-6
Consistency check, 8-1
Constant format,|3-31
Controller module, 2-13
Conversion, requirements, 4-2
Conversion instructions, 3-36
Convertible
address, A-1
instruction, A-3, A-4
COROS, 2-3
Counter instructions, 3-35
Counter module, 2-13
Counters, CPU, 2-6, 2-7
CP modules, 2-10
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Index

CPU,|5-3
analog inputs, 2-6, 2-7
analog outputs, |2-6, 2-7
bit memory, 2-6, 2-7
blocks,|2-6, 2-7
counters, 2-6, 2-7
DBs, 2-6, 2-7
digital inputs, 2-6, 2-7
digital outputs, 2-6, 2-7
FBs,|2-6,2-7
FCs,|2-6,2-7
load memory, 2-6, 2-7
local data, 2-6, 2-7
OBs,|2-6,2-7
process image, 2-6, 2-7
retentive data, 2-6
S7-300,/2-6
S7-400,2-7
SDBs, 2-7
SFBs,|2-6, 2-7
SFCs, 2-6, 2-7
timers, 2-6, 2-7
work memory, 2-6, 2-7
CRC, 3-23
Creating software, |3-13
inserting components, 3-15
Cross-referencelist, 6-1
Cycle monitoring time, 3-23
Cyclicinterrupt, 3-20

D

Datablock (DB), 3-17,(3-18
Data block instructions, 3-36
DB. See Data block

DB register, 3-41,/3-42

DB1, 3-26

DB1/DX0, 4-4, 5-4
Diagnostic buffer, 2-15
Diagnostic interrupt, 2-15, -2
DIL switches,|2-5
Distributed 1/O,|2-17

DP master, modules, 2-17
DP dave, modules, 2-17

DX. See Data block

DXO0, 3-26

E

Edge change, 2-15
Error handling,/3-21

Index-2

Error messages, 6-8
ET 200, 2-17
Ethernet, 2-10
Example
analog value processing, 9-2
block transfer, 9-11
start information, 9-8
temporary local data, 9-5
Expansion rack, 2-9

F

FB. See Function block
FC. See Function

FDL (SDA), 2-18

File formats, 3-40
Floating-point math, |3-28

Floating-point math instructions, 3-36

FM modules,|2-13

FMS master, 2-17

FMS service,|2-19

FMSdlaves, 2-17

Fully integrated automation, 1-1
Function (FC), 3-17, 3-18
Function block (FB),|3-17,|3-18
Function modules, 2-13

FX. See Function block

G

GD communication. See Global data

communication

Global data communication, 2-19

H

Handling block, 2-20
Hardware, STEP 7 object, 3-5
Hardware interrupt, 2-15, 3-20

HMI (Human Machine Interface), 2-3, 2-21

IM modules, 2-9
Importing
ASCII sourcefile, 3-16
symbol table, 3-40

Indirect addressing, converting, 7-4
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Industrial Ethernet, 2-10, 2-18
interface in user program, 2-20
modules, 2-11

Inputs
analog,|2-6, 2-7
digital, 2-6, 2-7

Installation, STEP 7 software, 3-2

Instruction
convertible, A-3,/A-4
non-convertible, |A-6

Instruction macro, 5-6

Instructions, overview, |3-35

Integer math instructions, 13-36

Interface modules, 2-9

Interprocessor communication flags, 3-23

Interrupt, 3-20, 3-22

Interrupt commands, |3-37

IP modules, 2-13

1SO transport, 2-18

1SO-on-TCPR, 2-18

J
Jump instructions,|3-37

L

LIR, 4-3
Load instructions, 3-35
Load memory
CPU S7-300, 2-6
CPU S7-400, 2-7
Local data, 3-33
CPU, 2-6, 2-7

M

Macro, 5-5

creating, |5-8
Math functions, 3-29, 3-38
Memory, |4-3
Module catalog, 3-10
Module information, 5-3
Module parameters, comparison S5/S7, 2-5
Modules, overview, [2-4
MPI, 2-3,/2-10, 2-18
Multicomputing interrupt, 3-20
Multipoint interface, 2-3
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N

Network, STEP 7 object, 3-5
Non-convertible

address, A-2

instruction, A-6
Null instructions, 3-38

O

OB. See Organization block
OB macro, 5-7
OB1, example, 9-14
Operator control and monitoring, 2-21
Operator Panel (OP), 2-21
Organization block (OB),|3-17,|3-20
Outputs

analog, 2-6, 2-7

digital,|2-6, 2-7

P

Page commands,|3-38
PB. See Program block
Performance, 2-2
PG interface, 2-10
Point-to-point connection, |2-10
interface in user program, 2-20
modules, 2-12
Pointer format,|3-43
Position detection modules, 2-13
Positioning module, 2-13
Power supply modules, 2-8
Processimage, CPU, 2-6, 2-7
Processing functions, (DO FW, DO DW), 4-3
PROFIBUS, 2-3,/2-10, 2-18
interface in user program, 2-20
modules, 2-11
Program block (PB), 3-17
Programmable controllers, overview, 2-2
Programmable modules, 3-6
Programming device interface
ASbh11, 2-3
MPI, 2-3
Project, 3-4
creating, 3-7
Project file, 3-4
Proportioning module, 2-13
ProTool, 2-22
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R

Register instructions, |3-35
Restart,|3-20
RET_VAL, 9-3
Retentive behavior, 4-4
Retentive data, CPU, 2-6
Retentivity, [2-7
Return value

of afunction, 9-3

of asystem function, 3-22
Rewire, 5-4, 7-2
Rotate instructions, |3-36

S

S5 expansion unit, |2-9

S5 handling block, 2-20

S5 standard function blocks, 7-6

S7 blocks, creating, 3-15

S7 project, creating, 4-4

SB. See Sequence block

Scratchpad flags, 3-33, 3-6

SDB. See System data block

Sequence block (SB),3-17

Set/read CPU time, 3-22

SFB. See System function block

SFC. See System function

Shift instructions,|3-36

Shift register, 3-23

Signal functions, 3-28

Signal modules,|2-15

Signal preprocessing modules, 2-13

SIMATIC Manager, |3-3
window, 3-13

SIMATIC S7, overview, 2-2

Simulator module, |2-16

SINEC H1, 2-11

SINEC L1,/2-11,|3-26

SINEC L2, 2-11,/3-26

SINEC S1, 2-11

SM modules, 2-15

Software, overview of components, 3-14

Sourcefile, STEP 7 object, 3-6

Special functions, 3-22

Special OBs, 3-17

Standard functions,|3-28

Standard library, 3-15

Start information, 3-34, 3-8

Startup,| 3-20

Index-4

Station, STEP 7 object, 3-5
STEP 5 block,|3-17
STEP5 project, 3-4
STEP7
installing, |3-2
starting, 3-3
STEP 7 project, |3-4
archiving, 3-8
components, |3-5
creating, 3-7
storing, 3-8
STL compiler, 8-1
Stop instructions, 3-37
Subnet, 2-10
Symbol, local, 3-40
Symbol table, 3-40
creating, 3-15
example, 9-14
STEP 7 object, 3-6
System data block (SDB), |3-17, 3-19
System function (SFC), 3-17,|3-19
System function block (SFB), 3-17, 3-19
System settings S5, 3-26

T

Time-delay interrupt, 3-20
Time-of-day interrupt, 3-20
Timer instructions, 3-35
Timers, CPU, 2-6, 2-7
TIR,/4-3

Tool, hardware conversion, 2-1
Transfer instructions, 3-35

U
User authorization, 3-2

V
Visualization, 2-22

w

Warning, Converter messages, 6-10
WinCC, 2-22

Word logic instructions, 3-36

Work memory, CPU, 2-6, 2-7
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